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Preface

This publication contains installation and configuration instructions for the IBM®

Tivoli® Storage Manager server, server languages, and other Tivoli Storage
Manager components.

Instructions for installing the Tivoli Storage Manager license, device driver, storage
agent, and the IBM Tivoli Storage Manager Operations Center are also included in
this publication.

Who should read this guide
This publication is intended for a system administrator installing and configuring a
Version 7.1 Tivoli Storage Manager server, the Operations Center, or upgrading
from Tivoli Storage Manager Version 6.

If you are upgrading an existing 5.5.x Tivoli Storage Manager server to Tivoli
Storage Manager Version 7.1, see the Upgrade and Migration Guide for V5 Servers.

If you are upgrading a Tivoli Storage Manager Version 6.1, Version 6.2, or Version
6.3 server to a newer version, see Chapter 5, “Upgrading to Tivoli Storage Manager
Version 7.1,” on page 69.

If you are upgrading an existing Tivoli Storage Manager Version 7.1 server to a
later level of Version 7.1, see Chapter 4, “Installing a Tivoli Storage Manager server
fix pack,” on page 65.

If you are installing or upgrading the Operations Center, see Part 3, “Installing and
upgrading the Operations Center,” on page 93.

Installable components
The IBM Tivoli Storage Manager server and licenses are required components.

You can install the following components for Tivoli Storage Manager V7.1.0 or
later.
v Tivoli Storage Manager server
v Tivoli Storage Manager server languages
v Tivoli Storage Manager licenses
v Tivoli Storage Manager devices
v Tivoli Storage Manager storage agent
v Tivoli Storage Manager Operations Center

Table 1 on page vi describes all the installable components.
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Table 1. Tivoli Storage Manager installable components

Tivoli Storage
Manager component

Description Additional information

Server (required) Includes the database,
GSKit, and tools to help
you configure and manage
Tivoli Storage Manager.

See the Tivoli Storage Manager server overview in the
Administrator's Guide.

Language package
(optional)

Each language package
(one for each language)
contains language-specific
information for the server.

See “Installing server language packages” on page 38.

Licenses (required) Includes support for all
Tivoli Storage Manager
licensed features. After you
install this package, you
must configure the licenses
you purchased.

See the chapter on managing server operations in the
Administrator's Guide.

Devices (optional) Extends Tivoli Storage
Manager media
management capability.

See the chapter on adding devices in the Administrator's Guide.

A list of devices that are supported by this driver is available
from the Tivoli Storage Manager website, at
http://www.ibm.com/support/entry/portal/Overview/
Software/Tivoli/Tivoli_Storage_Manager.

Storage agent
(optional)

Installs the component that
allows client systems to
write data directly to, or
read data directly from,
storage devices that are
attached to a storage area
network (SAN).
Remember: The IBM
Tivoli Storage Manager for
Storage Area Networks is a
separately licensed
product.

See the Storage Agent User's Guide.

Operations Center
(optional)

Installs the Operations
Center, which is a
web-based interface for
managing your storage
environment.

See Part 3, “Installing and upgrading the Operations Center,”
on page 93.

vi IBM Tivoli Storage Manager for Linux: Installation Guide

http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager


New for Tivoli Storage Manager Version 7.1

Many features in IBM Tivoli Storage Manager V7.1 are new for Tivoli Storage
Manager users. These changes affect the Tivoli Storage Manager server, the
Operations Center, the Administration Center, Tivoli Monitoring for Tivoli Storage
Manager, and the upgrade to V7.1.

These installation-related features are new for Tivoli Storage Manager in V7.1. For
a complete list of new V7.1 features, see the "What’s new in the products" topic in
the Tivoli Storage Manager information center at http://pic.dhe.ibm.com/
infocenter/tsminfo/v7r1.

DB2® Version 10.5 database implementation
Tivoli Storage Manager V7.1 is installed with the latest version of the IBM
DB2 database software, V10.5. The DB2 technology provides management
functions for the server database.

The previous Tivoli Storage Manager server release, V6.3, was packaged
with a DB2 V9.7 database.

If you are upgrading the server, you must ensure that the correct version
of DB2 is installed. If you are using a Tivoli Storage Manager V6.1 server,
and you want to upgrade to V7.1, you must upgrade the V6.1 server to
V6.2 or V6.3. Then, upgrade the server from V6.2 or V6.3 to V7.1. The
Tivoli Storage Manager V6.1 server was packaged with a DB2 V9.5
database, which cannot be upgraded to V10.5. The Tivoli Storage Manager
V6.2 and V6.3 servers were packaged with a DB2 V9.7 database, which can
be upgraded to V10.5.

IBM Installation Manager
In Tivoli Storage Manager V7.1, the server and Operations Center use IBM
Installation Manager to install or update software. If the required version
of IBM Installation Manager is not already installed, it is automatically
installed or upgraded when you install the Tivoli Storage Manager server
or Operations Center. It must remain installed on the system so that the
server or Operations Center can be updated or uninstalled later as needed.

Operations Center updates

The IBM Tivoli Storage Manager Operations Center is a web-based
interface for managing your storage environment.

Restriction: The Operations Center cannot be installed on HP-UX or
Oracle Solaris systems. However, you can use the Operations Center to
manage Tivoli Storage Manager V6.3.4 or later servers that run on HP-UX
or Oracle Solaris systems.

You can now do the following additional administrative tasks through the
Operations Center:
v Customize the settings for servers and clients by editing the server and

client properties.
v View or cancel the sessions and processes that are in progress by using

the Active Tasks view for servers.
v View the sessions and processes that succeeded or failed by using the

Completed Tasks view for servers.
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v View activity log messages that are related to specific alerts, sessions,
and processes. These activity log messages are available on the Alerts
page and in the Active Tasks and Completed Tasks views.

v Manually back up clients, storage pools, and the server database.
v View the replication server configuration for a client.
v Register clients, and configure basic backup settings.
v Suppress risk warnings for specific clients.
v View the authority level of the administrator ID that is used to log in to

the Operations Center.

Tivoli Monitoring for Tivoli Storage Manager availability
IBM Tivoli Monitoring for Tivoli Storage Manager is not delivered with
V7.1.

You can use Tivoli Monitoring for Tivoli Storage Manager V6.3.4 with any
Tivoli Storage Manager V5.5 or later server. For more information about
Tivoli Monitoring for Tivoli Storage Manager, see the Tivoli Storage
Manager V6.3 Information Center at: http://pic.dhe.ibm.com/infocenter/
tsminfo/v6r3/index.jsp

Administration Center availability
Although the Tivoli Storage Manager Administration Center is not
delivered with V7.1 or later versions, you can instead use the Operations
Center, which is a web-based interface for managing your storage
environment.

You can use the V6.3.4 Administration Center with any Tivoli Storage
Manager V6.3 or later server, including to automatically update
backup-archive clients. For more information about the Tivoli Storage
Manager Administration Center, see the Tivoli Storage Manager V6.3
Information Center at: http://pic.dhe.ibm.com/infocenter/tsminfo/v6r3/
index.jsp.
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Part 1. Installing and upgrading the server

Install and upgrade the Tivoli Storage Manager server.

Before you begin

Taking the first stepsPlanning to install Installing components

Figure 1. As highlighted in the figure, you are in the planning to install the Tivoli Storage Manager server section.
Review this section carefully to ensure that you have the system and other requirements needed to install Tivoli
Storage Manager.
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Chapter 1. Planning to install the Tivoli Storage Manager
server

Install the Tivoli Storage Manager server software on the computer that manages
storage devices and install the Tivoli Storage Manager client software on every
workstation that transfers data to Tivoli Storage Manager server-managed storage.

About this task

Tivoli Storage Manager server maintenance releases, client software, and
publications are available from the Tivoli Storage Manager website at
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Manager.

Allow approximately 30 - 45 minutes to install a Tivoli Storage Manager Version
7.1 server, using this guide.

An upgrade from V6.1.x, V6.2.x, or V6.3.x to V7.1 takes approximately 20 - 50
minutes. Your environment might produce different results than that obtained in
the labs.

The following figure illustrates the main parts for installing a new Tivoli Storage
Manager server.

What you should know first
Before installing IBM Tivoli Storage Manager, be familiar with your operating
systems, storage devices, communication protocols, and system configurations.

Table 2. Upgrade information

To upgrade from this
version To this version See this information

V7.1 V7.1 fix pack or interim fix Chapter 4, “Installing a Tivoli
Storage Manager server fix
pack,” on page 65

V6.2 or V6.3 V7.1 “Upgrading from Tivoli
Storage Manager V6.2 or
V6.3 to V7.1” on page 70

V6.1 V7.1 “Upgrading from Tivoli
Storage Manager V6.1 to
V7.1” on page 77

Planning
Preview and verify
server requirements Installing

Select a method to
install the software

First
steps

Configure and start the
server, register licenses,
prepare for backups
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Table 2. Upgrade information (continued)

To upgrade from this
version To this version See this information

V5.5 V7.1 Upgrade and Migration Guide
for V5 Servers

If you are migrating a Tivoli Storage Manager server, see the following
documentation:
v V5 server on a z/OS® operating system to V7.1 on an AIX® or Linux on System

z® operating system, see the Upgrade and Migration Guide for V5 Servers

v V5 server on an AIX, HP-UX, or Solaris operating system to V6.3.4 or later on a
Linux x86_64 operating system, see the Upgrade and Migration Guide for V5
Servers.

Restriction: You can install and run the Version 7.1 server on a system that already
has DB2 installed on it, whether DB2 was installed independently or as part of
some other application, with some restrictions. For details, see “Compatibility of
the Tivoli Storage Manager server with other DB2 products on the system” on
page 10.

Experienced DB2 administrators can choose to perform advanced SQL queries and
use DB2 tools to monitor the database. Do not, however, use DB2 tools to change
DB2 configuration settings from those that are preset by Tivoli Storage Manager, or
alter the DB2 environment for Tivoli Storage Manager in other ways, such as with
other products. The Tivoli Storage Manager Version 7.1 server has been built and
tested extensively using the data definition language (DDL) and database
configuration that Tivoli Storage Manager deploys.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack of DB2 software because doing so can damage
the database.

System requirements
To install Tivoli Storage Manager server on a Linux system, it is necessary to have
a minimum level of hardware and software, including a communication method
and the most current device driver.

These tables list the minimum hardware and software requirements for the
installation of a Tivoli Storage Manager server. Use these requirements as a starting
point. You can find the most current information about system requirements at
Tivoli Storage Manager Supported Operating Systems.

See Tivoli Storage Manager Optimizing Performance for server configuration
guidelines and best practices.

The Tivoli Storage Manager device driver package does not contain a device driver
for this operating system because a SCSI generic device driver is used. Configure
the device driver before using the Tivoli Storage Manager server with tape devices.
The Tivoli Storage Manager driver package contains driver tools and ACSLS
daemons. You can locate IBM driver packages at the Fix Central website.

Installing the Tivoli Storage Manager server
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Requirements, supported devices, client installation packages, and fixes are
available at the Tivoli Storage Manager website. After you have installed Tivoli
Storage Manager and before you customize it for your use, go to this website and
download and apply any applicable fixes: http://www.ibm.com/support/entry/
portal/Overview/Software/Tivoli/Tivoli_Storage_Manager.

Linux X86_64 server requirements
The Tivoli Storage Manager server on Linux X86_64 has hardware and software
requirements.

Hardware requirements

Table 3 describes the minimum hardware requirements that are needed for your
Tivoli Storage Manager Linux X86_64 system. For more details about planning disk
space, see “Capacity planning” on page 13.

Table 3. Hardware requirements

Type of
hardware Hardware requirements

Hardware An AMD64 or Intel EMT-64 processor

Disk space The following minimum values for disk space:

v 512 MB for the /var directory

v 4 GB for the installation directory

v 2 GB for the /tmp directory

v 300 MB for the /usr directory

v 2 GB in the home directory
Tip: Expect to use more space for problem determination.

v 2 GB for the shared resources area

Significant additional disk space is required for database and log files. The
size of the database depends on the number of client files to be stored and
the method by which the server manages them. The default active log
space is 16 GB, the minimum that is needed for most workloads and
configurations. Allocate at least three times the active log space for the
archive log (48 GB). Ensure that you have sufficient resources if you are
using data deduplication or expect a heavy client workload.

For optimal performance and to facilitate I/O, specify at least two equally
sized containers or Logical Unit Numbers (LUNs) for the database. See
Optimizing Performance for more information about the configuration of
directories for the database. In addition, each active log and archive log
should have its own container or LUN.

Ensure that you see the capacity planning section for more details about
disk space.
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Table 3. Hardware requirements (continued)

Type of
hardware Hardware requirements

Memory The following minimum values for memory:

v 12 GB.

v 16 GB if you are using data deduplication.

v At least 32 GB for heavily used servers. Using 32 GB or more of memory
enhances performance of the Tivoli Storage Manager server database
inventory.

v If you plan to run multiple instances, each instance requires the memory
listed for one server. Multiply the memory for one server by the number
of instances planned for the system.

v Node replication processing requires additional memory. Use a minimum
of 32 GB of memory for node replication without data deduplication.
Node replication with data deduplication requires a minimum of 64 GB
of memory.

v When you create the active log, you need at least 64 GB of memory to
run replication. If replication and deduplication are both being used,
create an active log of 128 GB in size.

Software requirements

Table 4 describes the minimum software requirements that are needed for your
Tivoli Storage Manager Linux X86_64 system.

Table 4. Software requirements

Type of
software Minimum software requirements

Operating
system

The Tivoli Storage Manager server on Linux X86_64 requires one of the
following operating systems:

v Red Hat Enterprise Linux 6

v SUSE Linux Enterprise Server 11, Service Pack 2

Installing the Tivoli Storage Manager server
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Table 4. Software requirements (continued)

Type of
software Minimum software requirements

Libraries GNU C libraries, Version 2.3.3-98.38 or later that is installed on the Tivoli
Storage Manager system.

For SUSE Linux Enterprise Servers:

v libaio

v libstdc++.so.5 at version 3.3 or later (32 and 64 bit packages are
required)

v libstdc++.so.6 at version 4.3 or later (32 and 64 bit packages are
required)

For Red Hat Enterprise Linux Servers:

v libaio

v libstdc++.so.6 (32 and 64 bit packages are required)

To determine if SELinux is installed and in enforcing mode, perform one
of the following tasks:

v Check the /etc/sysconfig/selinux file.

v Run the sestatus operating system command.

v Check the /var/log/messages file for SELinux notices.

To disable SELinux, complete one of the following tasks:

v Set permissive mode by issuing the setenforce 0 command as a
superuser.

v Modify the /etc/sysconfig/selinux file and reboot the machine.

Communication
protocol

v TCP/IP Version 4 or Version 6, which is standard with Linux

v Shared memory protocol (with Tivoli Storage Manager Version 7.1
Linux X86_64 client)

Processing Asynchronous I/O must be enabled. On Linux kernels at 2.6 or later,
install the libaio library to enable Asynchronous I/O.

Device drivers The Tivoli Storage Manager passthru device driver is used for non- IBM
devices. It uses the SCSI passthru interface to communicate with tape
devices and tape libraries. The Linux SCSI Generic (sg) device driver is
required for tape drives and tape libraries. The Tivoli Storage Manager
device driver package contains device driver tools and ACSLS daemons.

For the IBM 3590, 3592, or the Ultrium tape library or drives, the IBM
device drivers are required. Install the most current device drivers. You
can locate IBM driver packages at the Fix Central website:
http://www.ibm.com/support/fixcentral/.

Configure the device drivers before you use the Tivoli Storage Manager
server with tape devices.

Other software Korn Shell (ksh)

Installing the Tivoli Storage Manager server
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Linux on System z server requirements
The Tivoli Storage Manager server for Linux on System z has hardware and
software requirements.

Hardware requirements

Table 5 describes the minimum hardware requirements that are needed for your
Tivoli Storage Manager Linux on System z system. For more details about planning
disk space, see “Capacity planning” on page 13.

Table 5. Hardware requirements

Type of
hardware Hardware requirements

Hardware An IBM zSeries, IBM System z9®, IBM System z10®, or IBM zEnterprise®

System (z114 and z196) 64-bit native logical partition (LPAR) or z/VM®

guest.

Disk space The following minimum values for disk space:

v 512 MB for the /var directory

v 3 GB for the installation directory

v 2 GB for the /tmp directory

v 300 MB for the /usr directory

v 2 GB in the home directory
Tip: Expect to use more space for problem determination.

v 2 GB for the shared resources area

Significant additional disk space is required for database and log files. The
size of the database depends on the number of client files to be stored and
the method by which the server manages them. The default active log
space is 16 GB, the minimum that is needed for most workloads and
configurations. Allocate at least three times the active log space for the
archive log (48 GB). Ensure that you have sufficient resources if you are
using data deduplication or expect a heavy client workload.

For optimal performance and to facilitate I/O, specify at least two equally
sized containers or Logical Unit Numbers (LUNs) for the database. See
Optimizing Performance for more information about the configuration of
directories for the database. In addition, each active log and archive log
should have its own container or LUN.

Ensure that you see the capacity planning section for more details about
disk space.
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Table 5. Hardware requirements (continued)

Type of
hardware Hardware requirements

Memory The following minimum values for memory:

v 12 GB.

v 16 GB if you are using data deduplication.

v At least 32 GB for heavily used servers. Using 32 GB or more of memory
enhances performance of the Tivoli Storage Manager server database
inventory.

v If you plan to run multiple instances, each instance requires the memory
listed for one server. Multiply the memory for one server by the number
of instances planned for the system.

v Node replication processing requires additional memory. Use a minimum
of 32 GB of memory for node replication without data deduplication.
Node replication with data deduplication requires a minimum of 64 GB
of memory.

v When you create the active log, you need at least 64 GB of memory to
run replication. If replication and deduplication are both being used,
create an active log of 128 GB in size.

Software requirements

Table 6 describes the minimum software requirements that are needed for your
Tivoli Storage Manager Linux on System z system.

Table 6. Software requirements

Type of
software Minimum software requirements

Operating
system

The Tivoli Storage Manager server on Linux on System z (s390x 64-bit
architecture) requires one of the following operating systems:

v Red Hat Enterprise Linux 6

v SUSE Linux Enterprise Server 11, Service Pack 2

Libraries GNU C library, Version 2.4-31.43.6 is installed on the Tivoli Storage
Manager system.

For SUSE Linux Enterprise Servers:

v libaio

v libstdc++.so.5 at version 3.3 or later (32 and 64 bit packages are
required)

v libstdc++.so.6 at version 4.3 or later (32 and 64 bit packages are
required)

For Red Hat Enterprise Linux Servers:

v libaio

v libstdc++.so.6 (32 and 64 bit packages are required)

Communication
protocol

v TCP/IP Version 4 or Version 6, which is standard with Linux

v Shared memory protocol (with Tivoli Storage Manager Version 7.1
Linux on System z client)

Processing Asynchronous I/O must be enabled. On Linux kernels at 2.6 or later,
install the libaio library to enable Asynchronous I/O.

Other software Korn Shell (ksh)
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Compatibility of the Tivoli Storage Manager server with other DB2
products on the system

You can install other products that deploy and use DB2 products on the same
system as the Tivoli Storage Manager Version 7.1 server on AIX, HP-UX, Linux,
and Oracle Solaris platforms, with some limitations.

To install and use other products that use a DB2 product on the same system as
the Tivoli Storage Manager server, ensure that the following criteria are met:

Table 7. Compatibility of the Tivoli Storage Manager server with other DB2 products on the
system

Criterion Instructions

Version level The other products that use a DB2 product
must use DB2 version 9 or later. DB2
products include product encapsulation and
segregation support beginning with Version
9. Starting with this version, you can run
multiple copies of DB2 products, at different
code levels, on the same system. For details,
see the information about multiple DB2
copies: http://pic.dhe.ibm.com/infocenter/
db2luw/v10r5.

User IDs and directories Ensure that the user IDs, fence user IDs,
installation location, other directories, and
related information are not shared across
DB2 installations. Your specifications must
be different from the IDs and locations that
you used for the Tivoli Storage Manager
server installation and configuration. If you
used the dsmicfgx wizard or dsmupgdx
wizard to configure Version 7.1, or upgrade
the server from Version 5.5, these are values
that you entered when running the wizard.
If you used the manual configuration for
Version 7.1 or upgrade from Version 5.5
procedures, review the procedures that you
used if necessary to recall the values that
were used for the server.
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Table 7. Compatibility of the Tivoli Storage Manager server with other DB2 products on the
system (continued)

Criterion Instructions

Resource allocation Consider the resources and capability of the
system compared to the requirements for
both the Tivoli Storage Manager server and
the other applications that use the DB2
product. To provide sufficient resources for
the other DB2 applications, you might have
to change the Tivoli Storage Manager server
settings so that the server uses less system
memory and resources. Similarly, if the
workloads for the other DB2 applications
compete with the Tivoli Storage Manager
server for processor or memory resources,
the performance of the server in handling
the expected client workload or other server
operations might be adversely affected.

To segregate resources and provide more
capability for the tuning and allocation of
processor, memory, and other system
resources for multiple applications, consider
using logical partition (LPAR), workload
partition (WPAR), or other virtual
workstation support. For example, run a
DB2 application on its own virtualized
system.

IBM Installation Manager
Tivoli Storage Manager uses IBM Installation Manager, which is an installation
program that can use remote or local software repositories to install or update
many IBM products.

If the required version of IBM Installation Manager is not already installed, it is
automatically installed or upgraded when you install Tivoli Storage Manager. It
must remain installed on the system so that Tivoli Storage Manager can be
updated or uninstalled later as needed.

The following list contains explanations of some terms that are used in IBM
Installation Manager:

Offering
An installable unit of a software product.

The Tivoli Storage Manager offering contains all of the media that IBM
Installation Manager requires to install Tivoli Storage Manager.

Package
The group of software components that are required to install an offering.

The Tivoli Storage Manager package contains the following components:
v IBM Installation Manager installation program
v Tivoli Storage Manager offering

Package group
A set of packages that share a common parent directory.
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The default package group for the Tivoli Storage Manager package is IBM
Tivoli Storage Manager.

Repository
A remote or local storage area for data and other application resources.

The Tivoli Storage Manager package is stored in a repository on IBM Fix
Central.

Shared resources directory
A directory that contains software files or plug-ins that are shared by
packages.

IBM Installation Manager stores installation-related files in the shared
resources directory, including files that are used for rolling back to a
previous version of Tivoli Storage Manager.

Worksheets for planning details for the Tivoli Storage Manager server
You can use the worksheets to help you plan the amount and location of storage
needed for the Tivoli Storage Manager server. You can also use them to keep track
of names and user IDs.

See Tivoli Storage Manager Optimizing Performance for server configuration
guidelines and best practices.

Item Space required Number of directories Location of directories

The database

Active log

Archive log

Optional: Log mirror for
the active log

Optional: Secondary
archive log (failover
location for archive log)

Item Names and user IDs Location

The instance user ID for the
server, which is the ID you use
to start and run the Tivoli
Storage Manager server

The home directory for the server,
which is the directory that
contains the instance user ID

The database instance name

The instance directory for the
server, which is a directory that
contains files specifically for this
server instance (the server
options file and other
server-specific files)

Server name, use a unique name
for each server
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Capacity planning
Capacity planning for Tivoli Storage Manager includes managing resources such as
the database and recovery log. To maximize resources as part of capacity planning,
you must estimate space requirements for the database and the recovery log.

Procedure

For information about the benefits of deduplication and guidance on how to make
effective use of the Tivoli Storage Manager deduplication feature, see Optimizing
Performance.

Estimating space requirements for the database
To estimate space requirements for the database, you can use the maximum
number of files that can be in server storage at one time or you can use storage
pool capacity.

About this task

Consider using at least 25 GB for the initial database space. Provision file system
space appropriately. A database size of 25 GB is adequate for a test environment or
a library-manager-only environment. For a production server supporting client
workloads, the database size is expected to be larger. If you use random-access
disk (DISK) storage pools, more database and log storage space is needed than for
sequential-access storage pools.

The maximum size of the Tivoli Storage Manager database is 4 TB.

For information about sizing the database in a production environment that is
based on the number of files and on storage pool size, see the following topics.

Estimating database space requirements based on the number of
files
If you can estimate the maximum number of files that might be in server storage at
a time, you can use that number to estimate space requirements for the database.

About this task

To estimate space requirements that is based on the maximum number of files in
server storage, use the following guidelines:
v 600 - 1000 bytes for each stored version of a file, including image backups.

Restriction: The guideline does not include space that is used during data
deduplication.

v 100 - 200 bytes for each cached file, copy storage pool file, active-data pool file,
and deduplicated file.

v Additional space is required for database optimization to support varying
data-access patterns and to support server back-end processing of the data. The
amount of extra space is equal to 50% of the estimate for the total number of
bytes for file objects.

In the following example for a single client, the calculations are based on the
maximum values in the preceding guidelines. The examples do not take into
account that you might use file aggregation. In general, when you aggregate small
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files, it reduces the amount of required database space. File aggregation does not
affect space-managed files.

Procedure
1. Calculate the number of file versions. Add each of the following values to

obtain the number of file versions:
a. Calculate the number of backed-up files. For example, as many as 500,000

client files might be backed up at a time. In this example, storage policies
are set to keep up to three copies of backed up files:
500,000 files * 3 copies = 1,500,000 files

b. Calculate the number of archive files. For example, as many as 100,000
client files might be archived copies.

c. Calculate the number of space-managed files. For example, as many as
200,000 client files might be migrated from client workstations.

Using 1000 bytes per file, the total amount of database space that is required
for the files that belong to the client is 1.8 GB:
(1,500,000 + 100,000 + 200,000) * 1000 = 1.8 GB

2. Calculate the number of cached files, copy storage-pool files, active-data pool
files, and deduplicated files:
a. Calculate the number of cached copies. For example, caching is enabled in a

5 GB disk storage pool. The high migration threshold of the pool is 90%
and the low migration threshold of the pool is 70%. Thus, 20% of the disk
pool, or 1 GB, is occupied by cached files.
If the average file size is about 10 KB, approximately 100,000 files are in
cache at any one time:
100,000 files * 200 bytes = 19 MB

b. Calculate the number of copy storage-pool files. All primary storage pools
are backed up to the copy storage pool:
(1,500,000 + 100,000 + 200,000) * 200 bytes = 343 MB

c. Calculate the number of active storage-pool files. All the active
client-backup data in primary storage pools is copied to the active-data
storage pool. Assume that 500,000 versions of the 1,500,000 backup files in
the primary storage pool are active:
500,000 * 200 bytes = 95 MB

d. Calculate the number of deduplicated files. Assume that a deduplicated
storage pool contains 50,000 files:
50,000 * 200 bytes = 10 MB

Based on the preceding calculations, about 0.5 GB of extra database space is
required for the client’s cached files, copy storage-pool files, active-data pool
files, and deduplicated files.

3. Calculate the amount of extra space that is required for database optimization.
To provide optimal data access and management by the server, extra database
space is required. The amount of extra database space is equal to 50% of the
total space requirements for file objects.
(1.8 + 0.5) * 50% = 1.2 GB

4. Calculate the total amount of database space that is required for the client. The
total is approximately 3.5 GB:
1.8 + 0.5 + 1.2 = 3.5 GB

5. Calculate the total amount of database space that is required for all clients. If
the client that was used in the preceding calculations is typical and you have
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500 clients, for example, you can use the following calculation to estimate the
total amount of database space that is required for all clients:
500 * 3.5 = 1.7 TB

Results

Tip: In the preceding examples, the results are estimates. The actual size of the
database might differ from the estimate because of factors such as the number of
directories and the length of the path and file names. Periodically monitor your
database and adjust its size as necessary.

What to do next

During normal operations, the Tivoli Storage Manager server might require
temporary database space. This space is needed for the following reasons:
v To hold the results of sorting or ordering that are not already being kept and

optimized in the database directly. The results are temporarily held in the
database for processing.

v To give administrative access to the database through one of the following
methods:
– A DB2 open database connectivity (ODBC) client
– An Oracle Java™ database connectivity (JDBC) client
– Structured Query Language (SQL) to the server from an administrative-client

command line

Consider using an extra 50 GB of temporary space for every 500 GB of space for
file objects and optimization. See the guidelines in the following table. In the
example that is used in the preceding step, a total of 1.7 TB of database space is
required for file objects and optimization for 500 clients. Based on that calculation,
200 GB is required for temporary space. The total amount of required database
space is 1.9 TB.

Database size Minimum temporary-space requirement

< 500 GB 50 GB

≥ 500 GB and < 1 TB 100 GB

≥ 1 TB and < 1.5 TB 150 GB

≥ 1.5 and < 2 TB 200 GB

≥ 2 and < 3 TB 250 - 300 GB

≥ 3 and < 4 TB 350 - 400 GB

Estimating database space requirements based on storage pool
capacity
To estimate database space requirements based on storage pool capacity, use a ratio
of 1 - 5%. For example, if you require 200 TB of storage pool capacity, the size of
your database is expected to be 2 - 10 TB. As a general rule, make your database
as large as possible to prevent running out of space. If you run out of database
space, server operations and client-store operations can fail.
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The database manager and temporary space
The Tivoli Storage Manager server database manager manages and allocates
system memory and disk space for the database. The amount of database space
you require depends on the amount of system memory available and the server
workload.

The database manager sorts data in a specific sequence, as per the SQL statement
that you issue to request the data. Depending on the workload on the server, and
if there is more data than the database manager can manage, the data (that is
ordered in sequence) is allocated to temporary disk space. Data is allocated to
temporary disk space when there is a large result set. The database manager
dynamically manages the memory used when data is allocated to temporary disk
space.

For example, expiration processing can produce a large result set. If there is not
enough system memory on the database to store the result set, some of the data is
allocated to temporary disk space. During expiration processing, if a node or file
space are selected that are too large to process, the database manager does not
have enough memory to sort the data.

To run database operations, consider adding more database space for the following
scenarios:
v The database has a small amount of space and the server operation that requires

temporary space uses the remaining free space.
v The file spaces are large, or the file spaces has a policy assigned to it which

creates many file versions.
v The Tivoli Storage Manager server must run with limited memory. The database

uses the Tivoli Storage Manager server main memory to run database
operations. However, if there is insufficient memory available, the Tivoli Storage
Manager server allocates temporary space on disk to the database. For example,
if 10G of memory is available and database operations require 12G of memory,
the database uses temporary space.

v An out of database space error is displayed when you deploy a Tivoli Storage
Manager V6 server. Monitor the server activity log for messages related to
database space.

Important: Do not change the DB2 software that is installed with the Tivoli
Storage Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack, of DB2 software to avoid damage to the
database.

Recovery log space requirements
In Tivoli Storage Manager, the term recovery log comprises the active log, the
archive log, the active log mirror, and the archive failover log. The amount of space
that you require for the recovery log depends on various factors, including, for
example, the amount of client activity with the server.
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Active and archive log space
When you estimate space requirements for active and archive logs, include some
extra space for contingencies such as occasional heavy workloads and failovers.

In Tivoli Storage Manager servers V6.1 and later, the active log can be a maximum
size of 128 GB. The archive log size is limited to the size of the file system that it is
installed on.

Use the following general guidelines when you estimate the size of the active log:
v The suggested starting size for the active log is 16 GB.
v Ensure that the active log is at least large enough for the amount of concurrent

activity that the server typically handles. As a precaution, try to anticipate the
largest amount of work that the server manages at one time. Provision the active
log with extra space that can be used if needed. Consider using 20% of extra
space.

v Monitor used and available active log space. Adjust the size of the active log as
needed, depending upon factors such as client activity and the level of server
operations.

v Ensure that the directory that holds the active log is as large as, or larger than,
the size of the active log. A directory that is larger than the active log can
accommodate failovers, if they occur.

v Ensure that the file system that contains the active log directory has at least 8
GB of free space for temporary log movement requirements.

The suggested starting size for the archive log is 48 GB.

The archive log directory must be large enough to contain the log files that are
generated since the previous full backup. For example, if you perform a full
backup of the database every day, the archive log directory must be large enough
to hold the log files for all the client activity that occurs during 24 hours. To
recover space, the server deletes obsolete archive log files after a full backup of the
database. If the archive log directory becomes full and a directory for archive
failover logs does not exist, log files remain in the active log directory. This
condition can cause the active log directory to fill up and stop the server. When the
server restarts, some of the existing active-log space is released.

After the server is installed, you can monitor archive log utilization and the space
in the archive log directory. If the space in the archive log directory fills up, it can
cause the following problems:
v The server is unable to perform full database backups. Investigate and resolve

this problem.
v Other applications write to the archive log directory, exhausting the space that is

required by the archive log. Do not share archive log space with other
applications including other Tivoli Storage Manager servers. Ensure that each
server has a separate storage location that is owned and managed by that
specific server.

For guidance about the layout and tuning of the active log and archive log, see
Optimizing Performance.
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Example: Estimating active and archive log sizes for basic client-store
operations:

Basic client-store operations include backup, archive, and space management. Log
space must be sufficient to handle all store transactions that are in progress at one
time.

To determine the sizes of the active and archive logs for basic client-store
operations, use the following calculation:
number of clients x files stored during each transaction

x log space needed for each file

This calculation is used in the example in the following table.

Table 8. Basic client-store operations

Item
Example

values Description

Maximum number of client nodes
that back up, archive, or migrate files
concurrently at any time

300 The number of client nodes that back up, archive, or migrate
files every night.

Files stored during each transaction 4096 The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for each
file

3053 bytes The value of 3053 bytes for each file in a transaction
represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 -
120 bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 19.5 GB 1 Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3053 bytes for each file) ÷ 1,073,741,824
bytes = 3.5 GB

Increase that amount by the suggested starting size of 16
GB:

3.5 + 16 = 19.5 GB

Archive log: Suggested size 58.5 GB 1 Because of the requirement to be able to store archive logs
across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the total archive
log requirement.

3.5 x 3 = 10.5 GB

Increase that amount by the suggested starting size of 48
GB:

10.5 + 48 = 58.5 GB
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Table 8. Basic client-store operations (continued)

Item
Example

values Description
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Example: Estimating active and archive log sizes for clients that use multiple
sessions:

If the client option RESOURCEUTILIZATION is set to a value that is greater than the
default, the concurrent workload for the server increases.

To determine the sizes of the active and archive logs when clients use multiple
sessions, use the following calculation:
number of clients x sessions for each client x files stored

during each transaction x log space needed for each file

This calculation is used in the example in the following table.

Table 9. Multiple client sessions

Item Example values Description

Maximum number of client
nodes that back up, archive,
or migrate files concurrently
at any time

300 1000 The number of client nodes that back up, archive, or
migrate files every night.

Possible sessions for each
client

3 3 The setting of the client option RESOURCEUTILIZATION is
larger than the default. Each client session runs a maximum
of three sessions in parallel.

Files stored during each
transaction

4096 4096 The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for
each file

3053 3053 The value of 3053 bytes for each file in a transaction
represents the log bytes needed when backing up files from
a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.
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Table 9. Multiple client sessions (continued)

Item Example values Description

Active log: Suggested size 26.5 GB 1 51 GB 1 The following calculation was used for 300 clients. One GB
equals 1,073,741,824 bytes.

(300 clients x 3 sessions for each client x 4096 files
stored during each transaction x 3053 bytes for each
file) ÷ 1,073,741,824 = 10.5 GB

Increase that amount by the suggested starting size of 16
GB:

10.5 + 16 = 26.5 GB

The following calculation was used for 1000 clients. One
GB equals 1,073,741,824 bytes.

(1000 clients x 3 sessions for each client x 4096
files store during each transaction x 3053 bytes for
each file) ÷ 1,073,741,824 = 35 GB

Increase that amount by the suggested starting size of 16
GB:

35 + 16 = 51 GB

Archive log: Suggested size 79.5 GB 1 153 GB 1 Because of the requirement to be able to store archive logs
across three server-database backup cycles, the estimate for
the active log is multiplied by 3:

10.5 x 3 = 31.5 GB

35 x 3 = 105 GB

Increase those amounts by the suggested starting size of 48
GB:

31.5 + 48 = 79.5 GB

105 + 48 = 153 GB
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your active log and adjust its size if necessary.

Example: Estimating active and archive log sizes for simultaneous write
operations:

If client backup operations use storage pools that are configured for simultaneous
write, the amount of log space that is required for each file increases.

The log space that is required for each file increases by about 200 bytes for each
copy storage pool that is used for a simultaneous write operation. In the example
in the following table, data is stored to two copy storage pools in addition to a
primary storage pool. The estimated log size increases by 400 bytes for each file. If
you use the suggested value of 3053 bytes of log space for each file, the total
number of required bytes is 3453.
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This calculation is used in the example in the following table.

Table 10. Simultaneous write operations

Item
Example

values Description

Maximum number of client nodes
that back up, archive, or migrate files
concurrently at any time

300 The number of client nodes that back up, archive, or migrate
files every night.

Files stored during each transaction 4096 The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for each
file

3453 bytes 3053 bytes plus 200 bytes for each copy storage pool.

The value of 3053 bytes for each file in a transaction
represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 - 120
bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 20 GB 1 Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3453 bytes for each file) ÷ 1,073,741,824
bytes = 4.0 GB

Increase that amount by the suggested starting size of 16 GB:

4 + 16 = 20 GB

Archive log: Suggested size 60 GB 1 Because of the requirement to be able to store archive logs
across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the archive log
requirement:

4 GB x 3 = 12 GB

Increase that amount by the suggested starting size of 48 GB:

12 + 48 = 60 GB
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.
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Example: Estimating active and archive log sizes for basic client store operations
and server operations:

Migration of data in server storage, identification processes for data deduplication,
reclamation, and expiration might run concurrently with client store operations.
Administrative tasks such as administrative commands or SQL queries from
administrative clients can also run concurrently with client store operations. Server
operations and administrative tasks that run concurrently can increase the active
log space that is required.

For example, migration of files from the random-access (DISK) storage pool to a
sequential-access disk (FILE) storage pool uses approximately 110 bytes of log
space for each file that is migrated. For example, suppose that you have 300
backup-archive clients and each one of them backs up 100,000 files every night.
The files are initially stored on DISK and then migrated to a FILE storage pool. To
estimate the amount of active log space that is required for the data migration, use
the following calculation. The number of clients in the calculation represents the
maximum number of client nodes that back up, archive, or migrate files
concurrently at any time.
300 clients x 100,000 files for each client x 110 bytes = 3.1 GB

Add this value to the estimate for the size of the active log that calculated for basic
client store operations.

Example: Estimating active and archive log sizes under conditions of extreme
variation:

Problems with running out of active log space can occur if you have many
transactions that complete quickly and some transactions that take much longer to
complete. A typical case occurs when many workstation or file-server backup
sessions are active and a few very large database server-backup sessions are active.
If this situation applies to your environment, you might need to increase the size
of the active log so that the work completes successfully.

Example: Estimating archive log sizes with full database backups:

The Tivoli Storage Manager server deletes unnecessary files from the archive log
only when a full database backup occurs. Consequently, when you estimate the
space that is required for the archive log, you must also consider the frequency of
full database backups.

For example, if a full database backup occurs once a week, the archive log space
must be able to contain the information in the archive log for a full week.

The difference in archive log size for daily and full database backups is shown in
the example in the following table.

Table 11. Full database backups

Item
Example

values Description

Maximum number of client nodes
that back up, archive, or migrate files
concurrently at any time

300 The number of client nodes that back up, archive, or migrate
files every night.

Files stored during each transaction 4096 The default value of the server option TXNGROUPMAX is 4096.
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Table 11. Full database backups (continued)

Item
Example

values Description

Log space that is required for each
file

3453 bytes 3053 bytes for each file plus 200 bytes for each copy storage
pool.

The value of 3053 bytes for each file in a transaction
represents the log bytes needed when backing up files from
a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger than
3053 bytes if the data being stored has file names that are
longer than 12 - 120 bytes.

Active log: Suggested size 20 GB 1 Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files per transaction x 3453 bytes
per file) ÷ 1,073,741,824 bytes = 4.0 GB

Increase that amount by the suggested starting size of 16
GB:

4 + 16 = 20 GB

Archive log: Suggested size with a
full database backup every day

60 GB 1 Because of the requirement to be able to store archive logs
across three backup cycles, multiply the estimate for the
active log by 3 to estimate the total archive log requirement:

4 GB x 3 = 12 GB

Increase that amount by the suggested starting size of 48
GB:

12 + 48 = 60 GB

Archive log: Suggested size with a
full database every week

132 GB 1 Because of the requirement to be able to store archive logs
across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the total archive
log requirement. Multiply the result by the number of days
between full database backups:

(4 GB x 3 ) x 7 = 84 GB

Increase that amount by the suggested starting size of 48
GB:

84 + 48 = 132 GB
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested starting size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.
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Example: Estimating active and archive log sizes for data deduplication
operations:

If you deduplicate data, you must consider its effects on space requirements for
active and archive logs.

The following factors affect requirements for active and archive log space:

The amount of deduplicated data
The effect of data deduplication on the active log and archive log space
depends on the percentage of data that is eligible for deduplication. If the
percentage of data that can be deduplicated is relatively high, more log
space is required.

The size and number of extents
Approximately 1,500 bytes of active log space are required for each extent
that is identified by a duplicate-identification process. For example, if
250,000 extents are identified by a duplicate-identification process, the
estimated size of the active log is 358 MB:
250,000 extents identified during each process x 1,500 bytes
for each extent = 358 MB

Consider the following scenario. Three hundred backup-archive clients
back up 100,000 files each night. This activity creates a workload of
30,000,000 files. The average number of extents for each file is two.
Therefore, the total number of extents is 60,000,000, and the space
requirement for the archive log is 84 GB:
60,000,000 extents x 1,500 bytes for each extent = 84 GB

A duplicate-identification process operates on aggregates of files. An
aggregate consists of files that are stored in a given transaction, as
specified by the TXNGROUPMAX server option. Suppose that the TXNGROUPMAX
server option is set to the default of 4096. If the average number of extents
for each file is two, the total number of extents in each aggregate is 8192,
and the space required for the active log is 12 MB:
8192 extents in each aggregate x 1500 bytes for each extent =

12 MB

The timing and number of the duplicate-identification processes
The timing and number of duplicate-identification processes also affects the
size of the active log. Using the 12 MB active-log size that was calculated
in the preceding example, the concurrent load on the active log is 120 MB
if 10 duplicate-identification processes are running in parallel:
12 MB for each process x 10 processes = 120 MB

File size
Large files that are processed for duplicate identification can also affect the
size of the active log. For example, suppose that a backup-archive client
backs up an 80 GB, file-system image. This object can have a high number
of duplicate extents if, for example, the files included in the file system
image were backed up incrementally. For example, assume that a file
system image has 1.2 million duplicate extents. The 1.2 million extents in
this large file represent a single transaction for a duplicate-identification
process. The total space in the active log that is required for this single
object is 1.7 GB:
1,200,000 extents x 1,500 bytes for each extent = 1.7 GB
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If other, smaller duplicate-identification processes occur at the same time as
the duplicate-identification process for a single large object, the active log
might not have enough space. For example, suppose that a storage pool is
enabled for deduplication. The storage pool has a mixture of data,
including many relatively small files that range from 10 KB to several
hundred KB. The storage pool also has few large objects that have a high
percentage of duplicate extents.

To take into account not only space requirements but also the timing and
duration of concurrent transactions, increase the estimated size of the
active log by a factor of two. For example, suppose that your calculations
for space requirements are 25 GB (23.3 GB + 1.7 GB for deduplication of a
large object). If deduplication processes are running concurrently, the
suggested size of the active log is 50 GB. The suggested size of the archive
log is 150 GB.

The examples in the following tables show calculations for active and
archive logs. The example in the first table uses an average size of 700 KB
for extents. The example in the second table uses an average size of 256
KB. As the examples show, the average deduplicate-extent size of 256 KB
indicates a larger estimated size for the active log. To minimize or prevent
operational problems for the server, use 256 KB to estimate the size of the
active log in your production environment.

Table 12. Average duplicate-extent size of 700 KB

Item Example values Description

Size of largest single
object to deduplicate

800 GB 4 TB The granularity of processing for deduplication is at the file
level. Therefore, the largest single file to deduplicate
represents the largest transaction and a correspondingly
large load on the active and archive logs.

Average size of
extents

700 KB 700 KB The deduplication algorithms use a variable block method.
Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average size for extents.

Extents for a given
file

1,198,372
bits

6,135,667 bits Using the average extent size (700 KB), these calculations
represent the total number of extents for a given object.

The following calculation was used for an 800 GB object:
(800 GB ÷ 700 KB) = 1,198,372 bits

The following calculation was used for a 4 TB object: (4 TB ÷
700 KB) = 6,135,667 bits

Active log: Suggested
size that is required
for the deduplication
of a single large object
during a single
duplicate-
identification process

1.7 GB 8.6 GB The estimated active log space that are needed for this
transaction.
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Table 12. Average duplicate-extent size of 700 KB (continued)

Item Example values Description

Active log: Suggested
total size

66 GB 1 79.8 GB 1 After considering other aspects of the workload on the
server in addition to deduplication, multiply the existing
estimate by a factor of two. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.

The following calculation was used for multiple transactions
and an 800 GB object:

(23.3 GB + 1.7 GB) x 2 = 50 GB

Increase that amount by the suggested starting size of 16 GB:

50 + 16 = 66 GB

The following calculation was used for multiple transactions
and a 4 TB object:

(23.3 GB + 8.6 GB) x 2 = 63.8 GB

Increase that amount by the suggested starting size of 16 GB:

63.8 + 16 = 79.8 GB

Archive log:
Suggested size

198 GB 1 239.4 GB 1 Multiply the estimated size of the active log by a factor of 3.

The following calculation was used for multiple transactions
and an 800 GB object:

50 GB x 3 = 150 GB

Increase that amount by the suggested starting size of 48 GB:

150 + 48 = 198 GB

The following calculation was used for multiple transactions
and a 4 TB object:

63.8 GB x 3 = 191.4 GB

Increase that amount by the suggested starting size of 48 GB:

191.4 + 48 = 239.4 GB
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to
size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Table 13. Average duplicate-extent size of 256 KB

Item Example values Description

Size of largest single
object to deduplicate

800 GB 4 TB The granularity of processing for deduplication is at the file
level. Therefore, the largest single file to deduplicate
represents the largest transaction and a correspondingly
large load on the active and archive logs.
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Table 13. Average duplicate-extent size of 256 KB (continued)

Item Example values Description

Average size of
extents

256 KB 256 KB The deduplication algorithms use a variable block method.
Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average extent size.

Extents for a given
file

3,276,800 bits 16,777,216
bits

Using the average extent size, these calculations represent
the total number of extents for a given object.

The following calculation was used for multiple transactions
and an 800 GB object:

(800 GB ÷ 256 KB) = 3,276,800 bits

The following calculation was used for multiple transactions
and a 4 TB object:

(4 TB ÷ 256 KB) = 16,777,216 bits

Active log: Suggested
size that is required
for the deduplication
of a single large object
during a single
duplicate-
identification process

4.5 GB 23.4 GB The estimated size of the active log space that is required for
this transaction.

Active log: Suggested
total size

71.6 GB 1 109.4 GB 1 After considering other aspects of the workload on the
server in addition to deduplication, multiply the existing
estimate by a factor of 2. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.

The following calculation was used for multiple transactions
and an 800 GB object:

(23.3 GB + 4.5 GB) x 2 = 55.6 GB

Increase that amount by the suggested starting size of 16 GB:

55.6 + 16 = 71.6 GB

The following calculation was used for multiple transactions
and a 4 TB object:

(23.3 GB + 23.4 GB) x 2 = 93.4 GB

Increase that amount by the suggested starting size of 16 GB:

93.4 + 16 = 109.4 GB
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Table 13. Average duplicate-extent size of 256 KB (continued)

Item Example values Description

Archive log:
Suggested size

214.8 GB 1 328.2 GB 1 The estimated size of the active log multiplied by a factor of
3.

The following calculation was used for an 800 GB object:

55.6 GB x 3 = 166.8 GB

Increase that amount by the suggested starting size of 48 GB:

166.8 + 48 = 214.8 GB

The following calculation was used for a 4 TB object:

93.4 GB x 3 = 280.2 GB

Increase that amount by the suggested starting size of 48 GB:

280.2 + 48 = 328.2 GB
1 The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to
size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Active-log mirror space
The active log can be mirrored so that the mirrored copy can be used if the active
log files cannot be read. There can be only one active log mirror.

Creating a log mirror is a suggested option. If you increase the size of the active
log, the log mirror size is increased automatically. Mirroring the log can affect
performance because of the doubled I/O activity that is required to maintain the
mirror. The additional space that the log mirror requires is another factor to
consider when deciding whether to create a log mirror.

If the mirror log directory becomes full, the server issues error messages to the
activity log and to the db2diag.log. Server activity continues.

Archive-failover log space
The archive failover log is used by the server if the archive log directory runs out
of space.

Specifying an archive failover log directory can prevent problems that occur if the
archive log runs out of space. If both the archive log directory and the drive or file
system where the archive failover log directory is located become full, the data
remains in the active log directory. This condition can cause the active log to fill
up, which causes the server to halt.
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Monitoring space utilization for the database and recovery
logs

To determine the amount of used and available active log space, you issue the
QUERY LOG command. To monitor space utilization in the database and recovery
logs, you can also check the activity log for messages.

Active log

If the amount of available active log space is too low, the following messages are
displayed in the activity log:

ANR4531I: IC_AUTOBACKUP_LOG_USED_SINCE_LAST_BACKUP_TRIGGER
This message is displayed when the active log space exceeds the maximum
specified size. The Tivoli Storage Manager server starts a full database
backup.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANR0297I: IC_BACKUP_NEEDED_LOG_USED_SINCE_LAST_BACKUP
This message is displayed when the active log space exceeds the maximum
specified size. You must back up the database manually.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANR4529I: IC_AUTOBACKUP_LOG_UTILIZATION_TRIGGER
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. If at least one full database backup has occurred,
the Tivoli Storage Manager server starts an incremental database backup.
Otherwise, the server starts a full database backup.

ANR0295I: IC_BACKUP_NEEDED_LOG_UTILIZATION
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. You must back up the database manually.

Archive log

If the amount of available archive log space is too low, the following message is
displayed in the activity log:

ANR0299I: IC_BACKUP_NEEDED_ARCHLOG_USED
The ratio of used archive-log space to available archive-log space exceeds
the log utilization threshold. The Tivoli Storage Manager server starts a full
automatic database backup.

Database

If the amount of space available for database activities is too low, the following
messages are displayed in the activity log:

ANR2992W: IC_LOG_FILE_SYSTEM_UTILIZATION_WARNING_2
The used database space exceeds the threshold for database space
utilization. To increase the space for the database, use the EXTEND DBSPACE
command, the EXTEND DBSPACE command, or the DSMSERV FORMAT
utility with the DBDIR parameter.
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ANR1546W: FILESYSTEM_DBPATH_LESS_1GB
The available space in the directory where the server database files are
located is less than 1 GB.

When a Tivoli Storage Manager server is created with the DSMSERV
FORMAT utility or with the configuration wizard, a server database and
recovery log are also created. In addition, files are created to hold database
information used by the database manager. The path specified in this
message indicates the location of the database information used by the
database manager. If space is unavailable in the path, the server can no
longer function.

You must add space to the file system or make space available on the file
system or disk.

Server naming best practices
Use these descriptions as a reference when you install or upgrade a Tivoli Storage
Manager server.

Instance user ID

The instance user ID is used as the basis for other names related to the server
instance. The instance user ID is also called the instance owner.

For example: tsminst1

The instance user ID is the user ID that must have ownership or read/write access
authority to all directories that you create for the database and the recovery log.
The standard way to run the server is under the instance user ID. That user ID
must also have read/write access to the directories that are used for any FILE
device classes.

Home directory for the instance user ID

The home directory can be created when creating the instance user ID, by
using the option (-m) to create a home directory if it does not exist already.
Depending on local settings, the home directory might have the form:
/home/instance_user_ID

For example: /home/tsminst1

The home directory is primarily used to contain the profile for the user ID
and for security settings.

Database instance name

The database instance name must be the same as the instance user ID
under which you run the server instance.

For example: tsminst1

Instance directory

The instance directory is a directory that contains files specifically for a server
instance (the server options file and other server-specific files). It can have any
name that you want. For easier identification, use a name that ties the directory to
the instance name.
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You can create the instance directory as a subdirectory of the home
directory for the instance user ID. For example: /home/instance_user_ID/
instance_user_ID

The following example places the instance directory in the home directory
for user ID tsminst1: /home/tsminst1/tsminst1

You can also create the directory in another location, for example:
/tsmserver/tsminst1

The instance directory stores the following files for the server instance:
v The server options file, dsmserv.opt
v The server key database file, cert.kdb, and the .arm files (used by clients

and other servers to import the Secure Sockets Layer certificates of the
server)

v Device configuration file, if the DEVCONFIG server option does not specify
a fully qualified name

v Volume history file, if the VOLUMEHISTORY server option does not specify a
fully qualified name

v Volumes for DEVTYPE=FILE storage pools, if the directory for the
device class is not fully specified, or not fully qualified

v User exits
v Trace output (if not fully qualified)

Database name

The database name is always TSMDB1, for every server instance. This name cannot
be changed.

Server name

The server name is an internal name for Tivoli Storage Manager, and is used for
operations that involve communication among multiple Tivoli Storage Manager
servers. Examples include server-to-server communication and library sharing.

The server name is also used when you add the server to the Operations Center so
that it can be managed using that interface. Use a unique name for each server. For
easy identification in the Operations Center (or from a QUERY SERVER command),
use a name that reflects the location or purpose of the server. Do not change the
name of a Tivoli Storage Manager server after it is configured as a hub or spoke
server.

If you use the wizard, the default name that is suggested is the host name of the
system that you are using. You can use a different name that is meaningful in your
environment. If you have more than one server on the system and you use the
wizard, you can use the default name for only one of the servers. You must enter a
unique name for each server.

For example:

PAYROLL

SALES

For more information about server names, see the Administrator's Guide.
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Directories for database space and recovery log

The directories can be named according to local practices. For easier identification,
consider using names that tie the directories to the server instance.

For example, for the archive log:
/tsminst1_archlog

Installation directories
Installation directories for the Tivoli Storage Manager server include the server,
DB2, device, language, and other directories. Each one contains several additional
directories.

The default directories and their subdirectories are listed here for the server, DB2,
devices, and languages:
v Server directory (/opt/tivoli/tsm/server/bin), which contains:

– Server code and licensing
v Additional server directories:

– The command and message help are in the /opt/tivoli/tsm/server/bin
directory.

v DB2 directories

The DB2 product that is installed as part of the installation of the Tivoli Storage
Manager server has the directory structure as documented in DB2 information
sources. Protect these directories and files as you do the server directories.
– /opt/tivoli/tsm/db2

v Device directories

– /opt/tivoli/tsm/devices/bin

v Language directory

Language-dependent portions of the program are located here:
/opt/tivoli/tsm/server/bin

You can use US English, German, French, Italian, Spanish, Brazilian Portuguese,
Korean, Japanese, traditional Chinese, simplified Chinese, Chinese GBK, Chinese
Big5, and Russian.
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Chapter 2. Installing the Tivoli Storage Manager server
components

To install the Tivoli Storage Manager 7.1 server, you can use the graphical
installation wizard, the command line in console mode, or silent mode.

About this task

Using the Tivoli Storage Manager installation software, you can install the
following components:
v Tivoli Storage Manager Server

Tip: The database (DB2) and the Global Security Kit (GSKit) are automatically
installed when you select the server component.

v Tivoli Storage Manager Server Languages
v Tivoli Storage Manager License
v Tivoli Storage Manager Devices
v Tivoli Storage Manager Operations Center
v Tivoli Storage Manager Storage Agent

See the Storage Agent User's Guide for more details about storage agents.

Obtaining the Tivoli Storage Manager installation package
You can obtain the installation package from the product DVD or from an IBM
download site.

Before you begin

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:

ulimit -Hf

2. If the system user limit for maximum file size is not set to unlimited, change it
to unlimited by following the instructions in the documentation for your
operating system.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

Installing components Taking the first stepsPlanning to install
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Procedure
1. Download the appropriate package file from one of the following websites, or

you can access the files from the product DVD:
v For a first time installation or a new release go to Passport Advantage® at:

http://www.ibm.com/software/lotus/passportadvantage/. Passport
Advantage is the only site that you can download a licensed package file
from.

v For the latest information, updates, and maintenance fixes, go to the Tivoli
Storage Manager support site: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager.

2. If you download the package from one of the download sites, complete the
following steps:

a. Verify that you have enough space to store the installation files
when they are extracted from the product package. See the
download document for the space requirements:
v Tivoli Storage Manager: http://www.ibm.com/support/

docview.wss?uid=swg24035122
v Tivoli Storage Manager Extended Edition: http://www.ibm.com/

support/docview.wss?uid=swg24035635
v System Storage® Archive Manager: http://www.ibm.com/

support/docview.wss?uid=swg24035637
b. Download the package file to the directory of your choice. The path

must contain no more than 128 characters. Be sure to extract the
installation files to an empty directory. Do not extract to a directory
that contains previously extracted files, or any other files.
Also, ensure that you have executable permission for the package
file.

c. If necessary, change the file permissions by issuing the following
command:
chmod a+x package_name.bin

d. Issue the following command to extract the installation files:
./package_name.bin

where package_name is like the following example:
7.1.0.000-TIV-TSMSRV-LinuxX64.bin
7.1.0.000-TIV-TSMSRV-LinuxS390X.bin

3. Select one of the following methods of installing Tivoli Storage Manager:
v “Installing Tivoli Storage Manager by using the installation wizard” on page

35
v “Installing Tivoli Storage Manager by using console mode” on page 36
v “Installing Tivoli Storage Manager in silent mode” on page 37

4. After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager. Click Support and
downloads and apply any applicable fixes.
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Installing Tivoli Storage Manager by using the installation wizard
You can install or update Tivoli Storage Manager by using the IBM Installation
Manager graphical wizard.

Before you begin

Ensure that you review the following important information about installing the
server:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -g -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the graphical interface installation
wizard by issuing the following
command:

./install.sh

What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

v After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager. Click Support and
downloads and apply any applicable fixes.
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v After you install a new Tivoli Storage Manager server, review Taking the first
steps after you install Tivoli Storage Manager to learn about configuring your
server.

Installing Tivoli Storage Manager by using console mode
You can install or update Tivoli Storage Manager by using the command line in
console mode.

Before you begin

Ensure that you review the following important information about installing:
v Verify that the operating system is set to the language that you require. By

default, the language of the operating system is the language of the installation
wizard.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.
./install.sh -c -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure

Choose whether to install from a downloaded package file, or from the DVD, and
complete the following steps to begin the installation:

Option Description

Installing from a downloaded package file: 1. Change to the directory where you
downloaded the package file.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.

Installing from DVD media: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode, by issuing the following
command:

./install.sh -c

You can generate a response file as part
of a console mode installation. Complete
the console mode installation options,
and in the Summary panel, specify G to
generate the responses.
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What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

v After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager. Click Support and
downloads and apply any applicable fixes.

Installing Tivoli Storage Manager in silent mode
You can install or update the IBM Tivoli Storage Manager server in silent mode
without any user interaction.

Before you begin

A silent installation can use response files for data input. The following sample
response files are provided for installing, updating, and uninstalling the server:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

If you want to use one of the sample response files, they can be found after you
extract the package files, in the input subdirectory. You can use these sample files
as they are or you can customize them to suit your needs. It is optimal to use the
sample response files. These sample files contain instructions and default values to
help you avoid any unnecessary warnings.

On test servers only: Use the following command to bypass prerequisite checks
such as the operating system and the required memory. Do not issue this
command on a production server.

./install.sh -s -acceptLicense -vmargs "-DBYPASS_TSM_REQ_CHECKS=true"

Procedure
1. Create a response file, or use one of the sample response files such as

install_response_sample.xml or update_response_sample.xml.
2. To start the silent installation, issue one of the following commands from the

directory where the installation package file is extracted:

Option Description

Installing from a
downloaded package file or
DVD media:

To start the installation by accepting the default values,
issue the following command:

./install.sh -s -acceptLicense

To start the installation with a custom response file, issue
the following command, where response_file represents the
response file path, including the file name:

./install.sh -s -input response_file -acceptLicense
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What to do next
v If errors occur during the installation process, these errors are recorded in log

files that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

v After you install Tivoli Storage Manager, and before you customize it for your
use, go to the following website: http://www.ibm.com/support/entry/portal/
Overview/Software/Tivoli/Tivoli_Storage_Manager. Click Support and
downloads and apply any applicable fixes.

v After you install a new Tivoli Storage Manager server, review the information in
Taking the first steps after you install Tivoli Storage Manager to learn about
configuring your server.

Installing server language packages
Translations for the IBM Tivoli Storage Manager server allow the server to display
messages and help in languages other than U.S. English. The translations also
allow for the use of locale conventions for date, time, and number formatting.

Server language locales
Use either the default language package option or select another language package
to display server messages and help.

This language package is automatically installed for the following default language
option for Tivoli Storage Manager server messages and help:
v LANGUAGE en_US

For languages or locales other than the default, install the language package that
your installation requires.

You can use the languages that are shown:

Table 14. Server languages for Linux

LANGUAGE LANGUAGE option value

Chinese, Simplified zh_CN

zh_CN.gb18030

zh_CN.utf8

Chinese, Traditional Big5 / Zh_TW

zh_TW

zh_TW.utf8

English, United States en_US

en_US.utf8

French fr_FR

fr_FR.utf8

German de_DE

de_DE.utf8

Italian it_IT

it_IT.utf8
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Table 14. Server languages for Linux (continued)

LANGUAGE LANGUAGE option value

Japanese ja_JP

ja_JP.utf8

Korean ko_KR

ko_KR.utf8

Portuguese, Brazilian pt_BR

pt_BR.utf8

Russian ru_RU

ru_RU.utf8

Spanish es_ES

es_ES.utf8

Notes: For more information about setting the LANGUAGE option, see the Administrator's
Reference.

Restriction: For Operations Center users, some characters might not be displayed
properly if the web browser does not use the same language as the server. If this
problem occurs, set the browser to use the same language as the server.

Configuring a language package
After you configure a language package, messages and help are shown on the
Tivoli Storage Manager in languages other than US English. Installation packages
are provided with Tivoli Storage Manager.

About this task

To set support for a certain locale, complete one of the following tasks:
v Set the LANGUAGE option in the server options file to the name of the locale that

you want to use. For example:
To use the it_IT locale, set the LANGUAGE option to it_IT. See “Server
language locales” on page 38.

v If you are starting the server in the foreground, set the LC_ALL environment
variable to match the value that is set in the server options file. For example, to
set the environment variable for Italian, enter the following value:
export LC_ALL=it_IT

If the locale is successfully initialized, it formats the date, time, and number for the
server. If the locale is not successfully initialized, the server uses the US English
message files and the date, time, and number format.
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Updating a language package
You can modify or update a language package by using the IBM Installation
Manager.

About this task

You can install another language package within the same Tivoli Storage Manager
instance.
v Use the Modify function of IBM Installation Manager to install another language

package.
v Use the Update function of IBM Installation Manager to update to newer

versions of the language packages.

Tip: In IBM Installation Manager, the term update means to discover and install
updates and fixes to installed software packages. In this context, update and upgrade
are synonymous.
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Chapter 3. Taking the first steps after you install Tivoli
Storage Manager

After you install Tivoli Storage Manager Version 7.1, prepare for the configuration.
Using the configuration wizard is the preferred method of configuring the Tivoli
Storage Manager instance.

About this task

Configure the Tivoli Storage Manager server instance by completing the following
steps:
1. Update the kernel parameter values.

See “Tuning kernel parameters” on page 42.
2. Create the directories and user ID for the server instance. See “Creating the

user ID and directories for the server instance” on page 44.
3. Configure a Tivoli Storage Manager instance. Select one of the following

options:
v Use the Tivoli Storage Manager configuration wizard, the preferred method.

See “Configuring Tivoli Storage Manager using the configuration wizard” on
page 46.

v Manually configure the new Tivoli Storage Manager instance. See
“Configuring the server instance manually” on page 47. Complete the
following steps during a manual configuration.
a. Set up your directories and create the Tivoli Storage Manager instance.

See “Creating the server instance” on page 47.
b. Create a new server options file by copying the sample file to set up

communications between the server and clients. See “Configuring server
and client communications” on page 48.

c. Issue the DSMSERV FORMAT command to format the database. See
“Formatting the database and log” on page 52.

d. Configure your system for database backup. See “Preparing the database
manager for database backup” on page 52.

4. Configure options to control when database reorganization runs. See
“Configuring server options for server database maintenance” on page 54.

5. Start the Tivoli Storage Manager server instance if it is not already started.
See “Starting the server instance” on page 55.

6. Register your license. See “Registering licenses” on page 60.
7. Prepare your system for database backups. See “Specifying a device class in

preparation for database backups” on page 61.
8. Monitor the server. See “Monitoring the server” on page 62.

Taking the first stepsInstalling componentsPlanning to install

Figure 2. You are in the configuring the Tivoli Storage Manager server section.
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Tuning kernel parameters
For IBM Tivoli Storage Manager and DB2 to install and operate correctly on Linux,
you must update the kernel configuration parameters.

About this task

If you do not update these parameters, the installation of DB2 and Tivoli Storage
Manager might fail. Even if installation is successful, operational problems might
occur if you do not set parameter values.

Updating kernel parameters
DB2 automatically increases interprocess communication (IPC) kernel parameter
values to the preferred settings.

About this task

To update the kernel parameters on Linux servers, complete the following steps:

Procedure
1. Issue the ipcs -l command to list the parameter values.
2. Analyze the results to determine whether any changes are required for your

system. If changes are required, you can set the parameter in the
/etc/sysctl.conf file. The parameter value is applied when the system starts.

What to do next

For Red Hat Enterprise Linux 6 (RHEL6), you must set the kernel.shmmax
parameter in the /etc/sysctl.conf file before automatically starting the Tivoli
Storage Manager server on system startup.

For details about the DB2 database for Linux, see the DB2 information center:
http://pic.dhe.ibm.com/infocenter/db2luw/v10r5.

Suggested minimum values
Ensure that the values for kernel parameters are sufficient to prevent operational
problems from occurring when running the Tivoli Storage Manager server.

About this task

The following table contains the suggested minimum values for running DB2 on
your system. To run Tivoli Storage Manager with DB2, the values might need to be
increased above the minimum values specified here. In addition to implementing
the suggestions in this table, other changes are required to run both Tivoli Storage
Manager and DB2. For details, see http://www.ibm.com/support/
docview.wss?uid=swg27015156.

Parameter Description Preferred value

kernel.shmmni See note.

The maximum number of segments

256 × size of RAM
in GB
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Parameter Description Preferred value

kernel.shmmax See note.

The maximum size of a shared memory segment
(bytes)

size of RAM in bytes

kernel.shmall See note.

The maximum allocation of shared memory
pages (pages)

2 × size of RAM in
bytes (setting is in 4
KB pages)

kernel.sem (SEMMNI) See note.

The maximum number of arrays

256 × size of RAM
in GB

kernel.sem (SEMMSL) See note.

The maximum semaphores per array

250

kernel.sem (SEMMNS) See note.

The maximum semaphores per system

256,000

kernel.sem (SEMOPM) See note.

The maximum operations per semaphore call

32

kernel.msgmni See note.

The maximum number of system-wide message
queues

1024 × size of RAM
in GB

kernel.msgmax See note

The maximum size of messages (bytes)

65,536

kernel.msgmnb See note.

The default maximum size of queue (bytes)

65,536

kernel.randomize_va_space The kernel.randomize_va_space parameter
configures the kernels use of memory ASLR.
When you set the value to 0,
kernel.randomize_va_space=0, it disables ASLR.
DB2 data servers rely on fixed addresses for
certain shared memory objects, and the ASLR
can cause errors for some activities. To learn
more details about the Linux ASLR and DB2, see
the technote at: http://www.ibm.com/support/
docview.wss?uid=swg21365583.

0

vm.swappiness The vm.swappiness parameter defines whether
the kernel can swap application memory out of
physical random access memory (RAM). For
more information about kernel parameters, see
the http://pic.dhe.ibm.com/infocenter/db2luw/
v10r5.

0

vm.overcommit_memory The vm.overcommit_memory parameter influences
how much virtual memory the kernel can permit
to be allocated. For more information about
kernel parameters, see the http://
pic.dhe.ibm.com/infocenter/db2luw/v10r5.

0

Note: For Linux, DB2 automatically increases interprocess communication (IPC) kernel parameter values to the
preferred settings.
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Creating the user ID and directories for the server instance
Create the user ID for the Tivoli Storage Manager server instance and create the
directories that the Tivoli Storage Manager server instance needs for database and
recovery logs.

Before you begin

Review the information about planning space for the server before completing this
task. See “Worksheets for planning details for the Tivoli Storage Manager server”
on page 12.

Procedure
1. Create the user ID that will own the server instance. You use this user ID when

you create the server instance in a later step.

Create a user ID and group that will be the owner of the Tivoli Storage
Manager server instance.
a. The following commands can be run from an administrative user ID

that will set up the user and group. Create the user ID and group in
the home directory of the user.

Restriction: In the user ID, only lowercase letters (a-z), numerals
(0-9), and the underscore character ( _ ) can be used. The user ID
and group name must comply with the following rules:
v The length must be 8 characters or less.
v The user ID and group name cannot start with ibm, sql, sys, or a

numeral.
v The user ID and group name cannot be user, admin, guest, public,

local, or any SQL reserved word.
For example, create user ID tsminst1 in group tsmsrvrs. The
following examples show how to create this user ID and group
using operating system commands.
groupadd tsmsrvrs
useradd -d /home/tsminst1 -m -g tsmsrvrs -s /bin/bash tsminst1
passwd tsminst1

Restriction: DB2 does not support direct operating system user
authentication through LDAP.

b. Log off, then log in to your system. Change to the user account that
you just created. Use an interactive login program, such as telnet, so
that you are prompted for the password and can change it if
necessary.

2. Create directories that the server requires. Ensure that you are logged in under
the new user ID you just created.
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Create empty directories for each of the items shown in the following table. Mount the
associated storage to each directory for the active log, archive log and database directories.

Item
Example commands for
creating the directories Your directories

The instance directory for
the server, which is a
directory that will
contain files specifically
for this server instance
(the server options file
and other server-specific
files)

mkdir /tsminst1
chown tsminst1 /tsminst1

The database directories mkdir /tsmdb001
mkdir /tsmdb002
mkdir /tsmdb003
mkdir /tsmdb004

Active log directory mkdir /tsmlog

Archive log directory mkdir /tsmarchlog

Optional: Directory for
the log mirror for the
active log

mkdir /tsmlogmirror

Optional: Secondary
archive log directory
(failover location for
archive log)

mkdir /tsmarchlogfailover

When a server is initially created by using the DSMSERV FORMAT utility or the
configuration wizard, a server database and recovery log are created. In
addition, files are created to hold database information that is used by the
database manager.

3. Log off the new user ID.

Configuring Tivoli Storage Manager
After you have installed Tivoli Storage Manager Version 7.1 and prepared for the
configuration, configure the Tivoli Storage Manager server instance.

About this task

Configure a Tivoli Storage Manager server instance by selecting one of the
following options:
v Use the Tivoli Storage Manager configuration wizard on your local system. See

“Configuring Tivoli Storage Manager using the configuration wizard” on page
46.

v Manually configure the new Tivoli Storage Manager instance. See “Configuring
the server instance manually” on page 47. Complete the following steps during
a manual configuration.
1. Set up the directories and create the Tivoli Storage Manager instance. See

“Creating the server instance” on page 47.
2. Create a new server options file by copying the sample file in order to set up

communications between the Tivoli Storage Manager server and clients. See
“Configuring server and client communications” on page 48.
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3. Issue the DSMSERV FORMAT command to format the database. See
“Formatting the database and log” on page 52.

4. Configure your system for database backup. See “Preparing the database
manager for database backup” on page 52.

Configuring Tivoli Storage Manager using the configuration
wizard

The wizard offers a guided approach to configuring a server. By using the
graphical user interface (GUI), you can avoid some configuration steps that are
complex when done manually. Start the wizard on the system where you installed
the Tivoli Storage Manager server program.

Before you begin

Before beginning the configuration wizard, you must complete all preceding steps
to prepare for the configuration, including installing Tivoli Storage Manager,
creating the database and log directories, and creating the directories and user ID
for the server instance.

Procedure
1. Ensure that the following requirements are met:

v The system where you installed Tivoli Storage Manager must have the X
Window System client. You must also be running an X Window System
server on your desktop.

v The system must have one of the following protocols enabled. Ensure that
the port that the protocol uses is not blocked by a firewall.
– Secure Shell (SSH). Ensure that the port is set to the default value, 22.

Also, ensure that the SSH daemon service has access rights for connecting
to the system by using localhost.

– Remote shell (RSH).
– Remote Execution Protocol (REXEC).

v You must be able to log in to Tivoli Storage Manager with the user ID that
you created for the server instance, by using the SSH, RSH, or REXEC
protocol. When using the wizard, you must provide this user ID and
password to access that system.

2. Start the local version of the wizard:
Open the dsmicfgx program in the /opt/tivoli/tsm/server/bin directory.
This wizard can only be run as a root user.

Follow the instructions to complete the configuration. The wizard can be
stopped and restarted, but the server is not operational until the entire
configuration process is complete.
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Configuring the server instance manually
After installing Tivoli Storage Manager Version 7.1, you can configure Tivoli
Storage Manager manually instead of using the configuration wizard.

Creating the server instance
Create a Tivoli Storage Manager instance by issuing the db2icrt command.

About this task

You can have one or more server instances on one workstation.

Important: Before you run the db2icrt command, verify the following items:
v The home directory for the user (/home/tsminst1) exists. If there is no home

directory, you must create it.
The instance directory stores the following core files that are generated by the
Tivoli Storage Manager server:
– The server options file, dsmserv.opt
– The server key database file, cert.kdb, and the .arm files (used by clients and

other servers to import the Secure Sockets Layer certificates of the server)
– Device configuration file, if the DEVCONFIG server option does not specify a

fully qualified name
– Volume history file, if the VOLUMEHISTORY server option does not specify a

fully qualified name
– Volumes for DEVTYPE=FILE storage pools, if the directory for the device

class is not fully specified, or not fully qualified
– User exits
– Trace output (if not fully qualified)

v A shell configuration file (for example, .profile) exists in the home directory.
The root user and instance-user ID must have write permission to this file. For
more information, see the section on Linux and UNIX environment variable
settings in the DB2 Information Center at http://pic.dhe.ibm.com/infocenter/
db2luw/v10r5.

1. Log in using the root user ID and create a Tivoli Storage Manager instance. The
name of the instance must be the same name as the user that owns the
instance. Use the db2icrt command and enter the command on one line:
/opt/tivoli/tsm/db2/instance/db2icrt -a server -s ese -u
instance_name instance_name

For example, if your user ID for this instance is tsminst1, use the following
command to create the instance. Enter the command on one line.
/opt/tivoli/tsm/db2/instance/db2icrt -a server -s ese -u
tsminst1 tsminst1

Remember: From this point on, use this new user ID when you configure your
Tivoli Storage Manager server. Log out of the root user ID and log in under the
new instance-user ID.

2. Change the default directory for the database to be the same as the instance
directory for the server. If you have multiple servers, log in under the instance
ID for each server. Issue this command:
db2 update dbm cfg using dftdbpath instance_directory

For example:
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db2 update dbm cfg using dftdbpath /tsminst1

3. Modify the library path to use the version of the IBM Global Security Kit
(GSKit) that is installed with the Tivoli Storage Manager server. In the
following examples, server_bin_directory is a subdirectory of the server
installation directory. For example, /opt/tivoli/tsm/server/bin.
v You must update the following files to set the library path when DB2 or the

Tivoli Storage Manager server are started:
instance_directory/sqllib/usercshrc

instance_directory/sqllib/userprofile

v The following entry is added to the instance_directory/sqllib/usercshrc
file, on one line:
setenv LD_LIBRARY_PATH server_bin_directory/dbbkapi:
/opt/ibm/gsk8_64/lib64:$LD_LIBRARY_PATH

v The following entries are added to the instance_directory/sqllib/
userprofile file. Each entry is on one line.
LD_LIBRARY_PATH=server_bin_directory/dbbkapi:
/usr/local/ibm/gsk8_64/lib64:$LD_LIBRARY_PATH
export LD_LIBRARY_PATH

v Verify the library path settings and that the GSKit is version 8.0.14.14 or later.
Issue the following commands:
echo $LD_LIBRARY_PATH
gsk8capicmd_64 -version
gsk8ver_64

If your GSKit version is not 8.0.14.14 or later, you must reinstall the Tivoli
Storage Manager server. The reinstallation ensures that the correct GSKit
version is available.

4. Create a new server options file. See “Configuring server and client
communications.”

Configuring server and client communications
A default sample server options file, dsmserv.opt.smp, is created during Tivoli
Storage Manager installation in the /opt/tivoli/tsm/server/bin directory. You
must set up communications between the server and clients by creating a new
server options file. To do so, copy the sample file to the directory for the server
instance.

About this task

Ensure that you have a server instance directory, for example /tsminst1, and copy
the sample file to this directory. Name the new file dsmserv.opt and edit the
options. Complete this set-up before you initialize the server database (see
“Formatting the database and log” on page 52). Each sample or default entry in
the sample options file is a comment, a line beginning with an asterisk (*). Options
are not case-sensitive and one or more blank spaces are allowed between keywords
and values.

When editing the options file, follow these guidelines:
v Remove the asterisk at the beginning of the line to activate an option.
v Begin entering the options in any column.
v Enter only one option per line, and the option must be on only one line.
v If you make multiple entries for a keyword, the Tivoli Storage Manager server

uses the last entry.
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If you change the server options file, you must restart the server for the changes to
take effect. See the Administrator's Reference for a description of all server options.

You can specify one or more of the following communication methods:
v TCP/IP Version 4 or Version 6
v Shared memory
v Simple network management protocol (SNMP) DPI
v Secure Sockets Layer (SSL)

Note: You can authenticate passwords with the LDAP directory server, or
authenticate passwords with the Tivoli Storage Manager server. Passwords that
are authenticated with the LDAP directory server can provide enhanced system
security. For details, see the managing passwords and logon procedures section
in the Administrator's Guide.

Setting TCP/IP options:

Select from a range of TCP/IP options for the Tivoli Storage Manager server or
retain the default.

About this task

The following is an example of a list of TCP/IP options you can use to set up your
system.

commmethod tcpip
tcpport 1500
tcpwindowsize 0
tcpnodelay yes

Tip: You can use TCP/IP Version 4, Version 6, or both.

TCPPORT
The server TCP/IP port address. The default value is 1500.

TCPWINDOWSIZE
Specifies the size of the TCP/IP buffer that is used when sending or
receiving data. The window size that is used in a session is the smaller of
the server and client window sizes. Larger window sizes use additional
memory but can improve performance.

You can specify an integer from 0 to 2048. To use the default window size
for the operating system, specify 0.

TCPNODELAY
Specifies whether or not the server sends small messages or lets TCP/IP
buffer the messages. Sending small messages can improve throughput but
increases the number of packets sent over the network. Specify YES to
send small messages or NO to let TCP/IP buffer them. The default is YES.

TCPADMINPORT
Specifies the port number on which the server TCP/IP communication
driver is to wait for requests other than client sessions. The default value is
1500.

SSLTCPPORT
(SSL-only) Specifies the Secure Sockets Layer (SSL) port number on which
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the server TCP/IP communication driver waits for requests for
SSL-enabled sessions for the command-line backup-archive client and the
command-line administrative client.

SSLTCPADMINPORT
Specifies the port address on which the server TCP/IP communication
driver waits for requests for SSL-enabled sessions for the command-line
administrative client.

Setting shared memory options:

You can use shared memory communications between clients and servers on the
same system. To use shared memory, TCP/IP Version 4 must be installed on the
system.

About this task

The following example shows a shared memory setting:

commmethod sharedmem
shmport 1510

In this example, SHMPORT specifies the TCP/IP port address of a server when
using shared memory. Use the SHMPORT option to specify a different TCP/IP
port. The default port address is 1510.

COMMMETHOD can be used multiple times in the IBM Tivoli Storage Manager
server options file, with a different value each time. For example, the following
example is possible:

commmethod tcpip
commmethod sharedmem

You might receive the following message from the server when using shared
memory:
ANR9999D shmcomm.c(1598): ThreadId<39>
Error from msgget (2), errno = 28

The message means that a message queue must be created but the system limit for
the maximum number of message queues (MSGMNI) would be exceeded.

To find out the maximum number of message queues (MSGMNI) on your system,
issue the following command:
cat /proc/sys/kernel/msgmni

To increase the MSGMNI value on your system, issue the following command:
sysctl -w kernel.msgmni=n

where n is the maximum number of message queues that you want the system to
allow.
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Setting SNMP DPI subagent options:

Tivoli Storage Manager implements a simple network management protocol
(SNMP) subagent. You can configure the SNMP subagent to send traps to an
SNMP manager, such as NetView®, and to provide support for a Management
Information Base (MIB).

About this task

For details about configuring SNMP for use with Tivoli Storage Manager, see the
Administrator's Guide.

The subagent communicates with the snmp daemon, which in turn communicates
with a management application. The snmp daemon must support the DPI protocol.
Agents are available on AIX. The subagent process is separate from the Tivoli
Storage Manager server process, but the subagent gets its information from a
server options file. When the SNMP management application is enabled, it can get
information and messages from servers.

Use the following SNMP DPI options as an example of a SNMP setting. You must
specify the COMMMETHOD option. For details about the other options, see the
Administrator's Reference.

commmethod snmp
snmpheartbeatinterval 5
snmpmessagecategory severity

Setting Secure Sockets Layer options:

You can add more protection for your data and passwords by using Secure Sockets
Layer (SSL).

Before you begin

SSL is the standard technology for creating encrypted sessions between servers and
clients. SSL provides a secure channel for servers and clients to communicate over
open communication paths. With SSL, the identity of the server is verified through
the use of digital certificates.

To ensure better system performance, use SSL only for sessions when it is needed.
Consider adding additional processor resources on the Tivoli Storage Manager
server to manage the increased requirements.

Refer to setting up Transport Layer Security (TLS) in the Administrator's Guide.
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Formatting the database and log
Use the DSMSERV FORMAT utility to initialize a server instance. No other server
activity is allowed while initializing the database and recovery log.

After you set up server communications, you are ready to initialize the database.
Ensure that you log in by using the instance user ID. Do not place the directories
on file systems that might run out of space. If certain directories (for example, the
archive log) become unavailable or full, the server stops. See Capacity planning for
more details.

For optimal performance and to facilitate I/O, specify at least two equally sized
containers or Logical Unit Numbers (LUNs) for the database. See Optimizing
Performance for more information about the configuration of directories for the
database. In addition, each active log and archive log should have its own
container or LUN.

Initializing a server instance

Use the DSMSERV FORMAT utility to initialize a server instance. For example, issue the
following command:
dsmserv format dbdir=/tsmdb001 activelogsize=8192
activelogdirectory=/activelog archlogdirectory=/archlog
archfailoverlogdirectory=/archfaillog mirrorlogdirectory=/mirrorlog

Tip: If DB2 does not start after you issue the DSMSERV FORMAT command, you might
need to disable the file system mount option NOSUID. If this option is set on the file
system that contains the DB2 instance owner directory, or on any file system that
contains the DB2 database, active logs, archive logs, failover logs, or mirrored logs,
the option must be disabled to start the system.

After you disable the NOSUID option, remount the file system and then start DB2 by
issuing the following command:
db2start

For more information, see the Administrator's Reference.

Preparing the database manager for database backup
To back up the data in the database to Tivoli Storage Manager, you must enable
the database manager and configure the Tivoli Storage Manager application
programming interface (API).

About this task

Starting with Tivoli Storage Manager V7.1, it is no longer necessary to set the API
password during a manual configuration of the server. If you set the API password
during the manual configuration process, attempts to back up the database might
fail.

If you use the Tivoli Storage Manager configuration wizard to create a Tivoli
Storage Manager server instance, you do not have to complete these steps. If you
are configuring an instance manually, complete the following steps before you
issue either the BACKUP DB or the RESTORE DB commands.
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Attention: If the database is unusable, the entire Tivoli Storage Manager server is
unavailable. If a database is lost and cannot be recovered, it might be difficult or
impossible to recover data that is managed by that server. Therefore, it is critically
important to back up the database.

In the following commands, replace the example values with your actual values.
The examples use tsminst1 for the server instance user ID, /tsminst1 for the Tivoli
Storage Manager server instance directory, and /home/tsminst1 as the server
instance users home directory.
1. Set the Tivoli Storage Manager API environment-variable configuration for the

database instance:
a. Log in using the tsminst1 user ID.
b. When user tsminst1 is logged in, ensure that the DB2 environment is

properly initialized. The DB2 environment is initialized by running the
/home/tsminst1/sqllib/db2profile script, which normally runs
automatically from the profile of the user ID. Ensure the .profile file exists
in the instance users home directory, for example, /home/tsminst1/.profile.
If .profile does not run the db2profile script, add the following lines:
if [ -f /home/tsminst1/sqllib/db2profile ]; then

. /home/tsminst1/sqllib/db2profile
fi

c. For the instance_directory/sqllib/userprofile file, add the following
lines:
DSMI_CONFIG=server_instance_directory/tsmdbmgr.opt
DSMI_DIR=server_bin_directory/dbbkapi
DSMI_LOG=server_instance_directory
export DSMI_CONFIG DSMI_DIR DSMI_LOG

For the instance_directory/sqllib/usercshrc file, add the following lines:
setenv DSMI_CONFIG=server_instance_directory/tsmdbmgr.opt
setenv DSMI_DIR=server_bin_directory/dbbkapi
setenv DSMI_LOG=server_instance_directory

2. Log out and log in again as tsminst1, or issue this command:
. ~/.profile

Tip: Ensure that you enter a space after the initial dot (.) character.
3. Create a file that is called tsmdbmgr.opt in the server_instance directory, which is

in the /tsminst1 directory in this example, and add the following line:
SERVERNAME TSMDBMGR_TSMINST1

Remember: The SERVERNAME that you use must be consistent in the
tsmdbmgr.opt and dsm.sys files.

4. As root user, add the following lines to the Tivoli Storage Manager API dsm.sys
configuration file. The dsm.sys configuration file is in the following default
location:

server_bin_directory/dbbkapi/dsm.sys

servername TSMDBMGR_TSMINST1
commmethod tcpip
tcpserveraddr localhost
tcpport 1500
errorlogname /tsminst1
nodename $$_TSMDBMGR_$$

where
v servername matches the servername in tsmdbmgr.opt.
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v commethod is the client API used to contact the server for database backup.
This value can be tcpip or sharedmem. For sharedmem, see step 5..

v tcpserveraddr is the server address that the client API uses to contact the
server for database backup. This value must be localhost for database backup
to work.

v tcpport is the port number that the client API uses to contact the server for
database backup. Ensure that you enter the same tcpport option that is
specified in the dsmserv.opt server options file.

v errorlogname is the error log where the client API logs errors that are
encountered during a database backup. This log is typically in the server
instance directory. The log can, however, be placed anywhere the instance
user ID has write-permission.

v nodename is the node name that the client API uses to connect to the server
during a database backup. This value must be $$_TSMDBMGR_$$ for a database
backup to work.

Note: Do not add the PASSWORDACCESS generate option to the dsm.sys
configuration file. This option can cause the database backup to fail.

5. Optional: Configure the server to back up the database by using shared
memory. In this way, you might be able to reduce the processor load and
improve throughput. Complete the following steps:
a. Review the dsmserv.opt file. If the following lines are not in the file, add

them:
commmethod sharedmem
shmport port_number

where port_number specifies the port to be used for shared memory.
b. In the dsm.sys configuration file, locate the following lines:

commmethod tcpip
tcpserveraddr localhost
tcpport port_number

Replace the specified lines with the following lines:
commmethod sharedmem
shmport port_number

where port_number specifies the port to be used for shared memory.

Configuring server options for server database maintenance
To help avoid problems with database growth and server performance, the server
automatically monitors its database tables and reorganizes them when needed.
Before starting the server for production use, set server options to control when
reorganization runs. If you plan to use data deduplication, ensure that the option
to run index reorganization is enabled.

About this task

Table and index reorganization requires significant processor resources, active log
space, and archive log space. Because database backup takes precedence over
reorganization, select the time and duration for reorganization to ensure that the
processes do not overlap and reorganization can complete. For more information
about scheduling reorganization, see the Administrator's Guide.
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If you update these server options while the server is running, you must stop and
restart the server before the updated values take effect.

Procedure
1. Modify the server options.

Edit the server options file, dsmserv.opt, in the server instance directory. Follow
these guidelines when you edit the server options file:
v To activate an option, remove the asterisk at the beginning of the line.
v Create an option on any line.
v Enter only one option per line. The entire option with its value must be on

one line.
v If you have multiple entries for an option in the file, the server uses the last

entry.
v To view available server options, see the sample file, dsmserv.opt.smp, in the

/opt/tivoli/tsm/server/bin directory.
2. If you plan to use data deduplication, enable the ALLOWREORGINDEX server

option. Add the following option and value to the server options file:
allowreorgindex yes

3. Set the REORGBEGINTIME and REORGDURATION server options to control when
reorganization starts and how long it runs. Select a time and duration so that
reorganization runs when you expect that the server is least busy. These server
options control both table and index reorganization processes.
a. Set the time for reorganization to start by using the REORGBEGINTIME server

option. Specify the time by using the 24-hour system. For example, to set
the start time for reorganization as 8:30 p.m., specify the following option
and value in the server options file:
reorgbegintime 20:30

b. Set the interval during which the server can start reorganization. For
example, to specify that the server can start reorganization for four hours
after the time set by the REORGBEGINTIME server option, specify the following
option and value in the server options file:
reorgduration 4

4. If the server was running while you updated the server options file, stop and
restart the server.

Starting the server instance
You can start the Tivoli Storage Manager server by using the instance user ID or
the root user ID. You can also use the instance user ID or the root user ID to start
the server automatically.

Before you begin

Ensure that you set access permissions and user limits correctly. For instructions,
see “Verifying access rights and user limits” on page 56.

About this task

The preferred way to start the server is by using the instance user ID. By using the
instance user ID, you simplify the setup process and avoid potential issues.
However, in some cases, it might be necessary to start the server with the root user
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ID. For example, you might want to use the root user ID to ensure that the server
can access specific devices.

Procedure

To start the server, take one of the following actions:
v Start the server by using the instance user ID. For instructions, see “Starting the

server from the instance user ID” on page 58.
v Start the server by using the root user ID. For instructions, see “Starting the

server from the root user ID” on page 58.
v Start the server automatically.

For instructions, see “Automatically starting servers on Linux systems” on page
58.

For information about other options for starting the server, see the Administrator's
Guide.

Verifying access rights and user limits
Before you start the server, verify access rights and user limits.

About this task

If you do not verify user limits, also known as ulimits, you might experience server
instability or a failure of the server to respond. You must also verify the
system-wide limit for the maximum number of open files. The system-wide limit
must be greater than or equal to the user limit.

Procedure
1. Verify that the server instance user ID has permissions to start the server.
2. For the server instance that you plan to start, ensure that you have authority to

read and write files in the server instance directory. Verify that the dsmserv.opt
file exists in the server instance directory, and that the file includes parameters
for the server instance.

3. If the server is attached to a tape drive, medium changer, or removable media
device, and you plan to start the server by using the instance user ID, grant
read/write access to the instance user ID for these devices. To set permissions,
take one of the following actions:
v If the system is dedicated to Tivoli Storage Manager and only the Tivoli

Storage Manager administrator has access, make the device special file
world-writable:
chmod +w /dev/rmtX

v If the system has multiple users, you can restrict access by making the Tivoli
Storage Manager instance user ID the owner of the special device files:
chmod u+w /dev/rmtX

v If multiple user instances are running on the same system, change the group
name, for example TAPEUSERS, and add each Tivoli Storage Manager
instance user ID to that group. Then, change the ownership of the device
special files to belong to the group TAPEUSERS, and make them
group-writable:
chmod g+w /dev/rmtX

4. If you are using the Tivoli Storage Manager device driver and the autoconf
utility, use the -a option to grant read/write access to the instance user ID.
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5. To prevent server failures during interaction with DB2, tune the kernel
parameters.
For instructions about tuning kernel parameters, see “Tuning kernel
parameters” on page 42.

6. Verify the following user limits based on the guidelines in the table.

Table 15. User limit (ulimit) values

User limit type Standard value Command to query value

Maximum size of core files
created

Unlimited ulimit -Hc

Maximum size of a data
segment for a process

Unlimited ulimit -Hd

Maximum file size Unlimited ulimit -Hf

Maximum number of open
files

65536 ulimit -Hn

Maximum amount of
processor time in seconds

Unlimited ulimit -Ht

To modify user limits, follow the instructions in the documentation for your
operating system.

Tip: If you plan to start the server automatically by using a script, you can set
the user limits in the script.

7. Ensure that the user limit of maximum user processes (nproc) is set to the
minimum suggested value of 16384.
a. To verify the current user limit, issue the following command by using the

instance user ID:
ulimit -Hu

For example:
[user@Machine ~]$ ulimit -Hu
16384

b. If the limit of maximum user processes is not set to 16384, set the value to
16384.
Add a line to the /etc/security/limits.conf file.
If the server is installed on the Red Hat Enterprise Linux 6 operating
system, set the user limit by editing the /etc/security/limits.d/90-
nproc.conf file in the /etc/security/limits.d directory. This file overrides
the settings in the /etc/security/limits.conf file.

Tip: The default value for the user limit of maximum user processes has
changed on some distributions and versions of the Linux operating system.
The default value is 1024. If you do not change the value to the minimum
suggested value of 16384, the server might fail or hang.
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Starting the server from the instance user ID
To start the server from the instance user ID, log in with the instance user ID and
issue the appropriate command from the server instance directory.

Before you begin

Ensure that access rights and user limits are set correctly. For instructions, see
“Verifying access rights and user limits” on page 56.

Procedure
1. Log in to the system where Tivoli Storage Manager is installed by using the

instance user ID for the Tivoli Storage Manager server.
2. If you do not have a user profile that runs the db2profile script, issue the

following command:
. /home/tsminst1/sqllib/db2profile

Tip: For instructions about updating the user ID login script to run the
db2profile script automatically, see the DB2 documentation.

3. Start the server by issuing the following command from the server instance
directory:
/usr/bin/dsmserv

Tip: The command runs in the foreground so that you can set an administrator
ID and connect to the server instance.
For example, if the name of the Tivoli Storage Manager server instance is
tsminst1 and the server instance directory is /tsminst1, you can start the
instance by issuing the following commands:
cd /tsminst1
. ~/sqllib/db2profile
/usr/bin/dsmserv

Starting the server from the root user ID
The standard way to start the server is by using the instance user ID. However, in
some cases, it might be necessary to use another user ID to start the server. For
example, you might want to use the root user ID to ensure that the server can
access specific devices.

Before you begin

For information about authorizing root users and starting the server by using the
root user ID, see the Administrator's Guide.

Automatically starting servers on Linux systems
To automatically start a Tivoli Storage Manager server on a Linux operating
system, use the dsmserv.rc script.

Before you begin

Ensure that kernel parameters are set correctly. For instructions, see “Tuning kernel
parameters” on page 42.

Ensure that the Tivoli Storage Manager server instance runs under the instance
owner user ID.
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Ensure that access rights and user limits are set correctly. For instructions, see
“Verifying access rights and user limits” on page 56.

About this task

The dsmserv.rc script is in the server installation directory, for example,
/opt/tivoli/tsm/server/bin.

The dsmserv.rc script can be used either to start the server manually or to start the
server automatically by adding entries to the /etc/rc.d/init.d directory. The
script works with Linux utilities such as CHKCONFIG and SERVICE.

Procedure

For each server instance that you want to automatically start, complete the
following steps:
1. Place a copy of the dsmserv.rc script in the /init.d directory, for example,

/etc/rc.d/init.d.
Ensure that you make any changes in the copy of the script. Do not change the
original script.

2. Rename the script copy so that it matches the name of the server instance
owner, for example, tsminst1.
The script was created under the assumption that the server instance directory
is home_directory/tsminst1, for example: /home/tsminst1/tsminst1.

3. If the server instance directory is not home_directory/tsminst1, locate the
following line in the script copy:
instance_dir="${instance_home}/tsminst1"

Change the line so that it points to your server instance directory, for example:
instance_dir="/tsminst1"

4. Use tools such as the CHKCONFIG utility to configure the run level in which the
server automatically starts. Specify a value that corresponds to a multiuser
mode, with networking turned on. Typically, the run level to use is 3 or 5,
depending on the operating system and its configuration. For more information
about multiuser mode and run levels, see the documentation for your operating
system.

5. Optional: You can start or stop the server by issuing one of the following
commands:
v To start the server:

service tsminst1 start

v To stop the server:
service tsminst1 stop

Example

In this example, the instance owner is tsminst1 and the server instance directory is
/home/tsminst1/tsminst1. The dsmserv.rc script copy is named tsminst1, and the
CHKCONFIG utility is used to configure the script to start at run levels 3, 4, and 5.
cp /opt/tivoli/tsm/server/bin/dsmserv.rc /etc/rc.d/init.d/tsminst1
chkconfig --list tsminst1
service tsminst1 supports chkconfig, but is not referenced in
any runlevel (run ’chkconfig --add tsminst1’)
chkconfig --add tsminst1
chkconfig --list tsminst1
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tsminst1 0:off 1:off 2:off 3:off 4:off 5:off 6:off
chkconfig --level 345 tsminst1 on
chkconfig --list tsminst1
tsminst1 0:off 1:off 2:off 3:on 4:on 5:on 6:off

Stopping the server
You can stop the server when needed to return control to the operating system. To
avoid losing administrative and client node connections, stop the server only after
current sessions are completed or canceled.

About this task

To stop the server, issue the following command from the Tivoli Storage Manager
command line:
halt

The server console stops.

If you cannot connect to the server with an administrative client and you want to
stop the server, you must cancel the process by using the kill command with the
process ID number (pid) that is displayed at initialization.

Important: Before you issue the kill command, ensure that you know the correct
process ID for the Tivoli Storage Manager server.
The dsmserv.v6lock file, in the directory from which the server is running, can be
used to identify the process ID of the process to kill. To display the file enter:
cat /instance_dir/dsmserv.v6lock

Issue the following command to stop the server:
kill -23 dsmserv_pid

where dsmserv_pid is the process ID number.

Registering licenses
Immediately register any Tivoli Storage Manager licensed functions that you
purchase so you do not lose any data after you start server operations, such as
backing up your data.

About this task

Use the REGISTER LICENSE command for this task.

Example: Register a license

Register the base Tivoli Storage Manager license.
register license file=tsmbasic.lic
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Specifying a device class in preparation for database backups
To prepare the system for automatic and manual database backups, you must
specify the device class to be used.

Before you begin

Before you begin the setup, ensure that you have defined a tape or file device
class. See the defining device classes section of the Administrator's Guide.

About this task

To set up your system for database backups, issue the SET DBRECOVERY command to
specify a device class to be used for the backups. You can also change the device
class to be used for database backups with the SET DBRECOVERY command.

Perform the following setup procedure:

Procedure
1. If you did not use the configuration wizard (dsmicfgx) to configure the server,

ensure that you have completed the steps to manually configure the system for
database backups.

2. Select the device class to be used for backups of the database. Issue the
following command from a IBM Tivoli Storage Manager administrative
command line.
set dbrecovery device_class_name

The device class that you specify is used by the database manager for database
backups. If you do not specify a device class with the SET DBRECOVERY
command, the backup fails.

Example

For example, to specify that the DBBACK device class is to be used, issue this
command:
set dbrecovery dbback

What to do next

When you are ready to back up your database, see the BACKUP DB command in the
Administrator's Reference.

Running multiple server instances on a single system
You can create more than one server instance on your system. Each server instance
has its own instance directory, and database and log directories.

Multiply the memory and other system requirements for one server by the number
of instances planned for the system.

The set of files for one instance of the server is stored separately from the files
used by another server instance on the same system. Use the steps in “Creating the
server instance” on page 47 for each new instance, including creation of the new
instance user.
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To manage the system memory that is used by each server, use the DBMEMPERCENT
server option to limit the percentage of system memory. If all servers are equally
important, use the same value for each server. If one server is a production server
and other servers are test servers, set the value for the production server to a
higher value than the test servers.

When you upgrade from Tivoli Storage Manager V6.1, you must upgrade to V6.3
first, and then to V7.1. You can upgrade directly from either V6.2 or V6.3 to V7.1.
See the upgrade section (Chapter 5, “Upgrading to Tivoli Storage Manager Version
7.1,” on page 69) for more details. When you upgrade and have multiple servers
on your system, you must run the installation wizard only once. The installation
wizard collects the database and variables information for all of your original
server instances.

If you upgrade from Tivoli Storage Manager V6.2 or V6.3 to V7.1 and have
multiple servers on your system, all instances that exist in DB2 V9.7 are dropped
and recreated in DB2 V10.5. The wizard issues the db2 upgrade db dbname
command for each database. The database environment variables for each instance
on your system are also reconfigured during the upgrade process.

For information about the Server Initialization wizard, see the Tivoli Storage
Manager Administrator's Guide.

Monitoring the server
When you start using server in production operation, monitor the space used by
the server to ensure that the amount of space is adequate. Make adjustments as
needed.

Procedure
1. Monitor the active log, to ensure that the size is correct for the workload that is

handled by the server instance.
When the server workload is up to its typical expected level, and the space that
is used by the active log is 80 - 90% of the space that is available to the active
log directory, you might need to increase the amount of space. Whether you
need to increase the space depends on the types of transactions in the server's
workload, because transaction characteristics affect how the active log space is
used.
The following transaction characteristics can affect the space usage in the active
log:
v The number and size of files in backup operations

– Clients such as file servers that back up large numbers of small files can
cause large numbers of transactions that complete during a short period of
time. The transactions might use a large amount of space in the active log,
but for a short period of time.

– Clients such as a mail server or a database server that back up large
chunks of data in few transactions can cause small numbers of
transactions that take a long time to complete. The transactions might use
a small amount of space in the active log, but for a long period of time.

v Network connection types
– Backup operations that occur over fast network connections cause

transactions that complete more quickly. The transactions use space in the
active log for a shorter period of time.

Installing the Tivoli Storage Manager server

62 IBM Tivoli Storage Manager for Linux: Installation Guide



– Backup operations that occur over relatively slower connections cause
transactions that take a longer time to complete. The transactions use
space in the active log for a longer period of time.

If the server is handling transactions with a wide variety of characteristics, the
space that is used for the active log might go up and down by a large amount
over time. For such a server, you might need to ensure that the active log
typically has a smaller percentage of its space used. The extra space allows the
active log to grow for transactions that take a very long time to complete, for
example.

2. Monitor the archive log to ensure that space is always available.

Remember: If the archive log becomes full, and the failover archive log
becomes full, the active log can become full and the server will stop. The goal
is to make enough space available to the archive log so that it never uses all its
available space.
You are likely to notice the following pattern:
a. Initially, the archive log grows rapidly as typical client-backup operations

occur.
b. Database backups occur regularly, either as scheduled or done manually.
c. After at least two full database backups occur, log pruning occurs

automatically. The space used by the archive log decreases when the
pruning occurs.

d. Normal client operations continue, and the archive log grows again.
e. Database backups occur regularly, and log pruning occurs as often as full

database backups occur.
With this pattern, the archive log grows initially, then decreases, then might
grow again. Over a period of time, as normal operations continue, the amount
of space used by the archive log should reach a relatively constant level.
If the archive log continues to grow, consider taking one or both of these
actions:
v Add space to the archive log. This might mean moving the archive log to a

different file system.
For information about moving the archive log, see the Tivoli Storage Manager
Administrator's Guide.

v Increase the frequency of full database backups, so that log pruning occurs
more frequently.

3. If you defined a directory for the failover archive log, determine whether any
logs get stored in that directory during normal operations. If the failover log
space is being used, consider increasing the size of the archive log. The goal is
that the failover archive log is used only under unusual conditions, not in
normal operation.

What to do next

For details about monitoring, see the Administrator's Guide.
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Chapter 4. Installing a Tivoli Storage Manager server fix pack

Tivoli Storage Manager maintenance updates, which are also referred to as fix
packs, bring your server up to the current maintenance level.

Before you begin

To install a fix pack or interim fix to the server, install the server at the level on
which you want to run it. You do not have to start the server installation at the
base release level. For example, if you currently have Version 6.3.4.2 installed, you
can go directly to the latest fix pack for V7.1. You do not have to start with the
V7.1.0 installation if a maintenance update is available.

You must have the Tivoli Storage Manager license package installed. The license
package is provided with the purchase of a base release. Alternatively, you can
obtain the license package when download a fix pack from the Passport Advantage
website. After the fix pack or interim fix is installed, install the license for the
server. To display messages and help in a language other than US English, install
the language package of your choice.

For information about the estimated time required to install a fix pack, see Techdoc
7023591.

If you upgrade the server to V7.1 or later, and then revert the server to a level that
is earlier than V7.1, you must restore the database to a point in time before the
upgrade. During the upgrade process, complete the required steps to ensure that
the database can be restored: back up the database, the volume history file, the
device configuration file, and the server options file. For more information, see
Chapter 6, “Reverting from Version 7.1 to the previous V6 server,” on page 79.

Ensure that you retain the installation media from the base release of the installed
server. If you installed Tivoli Storage Manager from a DVD, ensure that the DVD is
available. If you installed Tivoli Storage Manager from a downloaded package,
ensure that the downloaded files are available. If the upgrade fails, and the server
license module is uninstalled, the installation media from the server base release
are required to reinstall the license.

Visit this website: http://www.ibm.com/support/entry/portal/Overview/
Software/Tivoli/Tivoli_Storage_Manager for the following information:
v A list of the latest maintenance and download fixes. Click Support and

downloads and apply any applicable fixes.
v Details about obtaining a base license package. Search for Warranties and

licenses.
v Supported platforms and system requirements. Click Server requirements.

© Copyright IBM Corp. 1993, 2013 65

http://www.ibm.com/support/docview.wss?uid=swg27023591
http://www.ibm.com/support/docview.wss?uid=swg27023591
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/Tivoli_Storage_Manager


About this task

To install a fix pack or interim fix, complete the following steps.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack of DB2 software because doing so can damage
the database.

Procedure
1. Log in as the root user.
2. Obtain the package file for the fix pack or interim fix that you want to install

from the http://www.ibm.com/support/entry/portal/Overview/Software/
Tivoli/Tivoli_Storage_Manager site.

3. Change to the directory where you placed the executable file and complete the
following steps.

Tip: The files are extracted to the current directory. Ensure that the executable
file is in the directory where you want the extracted files to be located.
a. Change file permissions by entering the following command:

chmod a+x 6.x.x.x-TIV-TSMALL-platform.bin

where platform denotes the architecture that Tivoli Storage Manager is to
be installed on.

b. Issue the following command to extract the installation files:
./6.x.x.x-TIV-TSMALL-platform.bin

4. Back up the database. The preferred method is to use a snapshot backup. A
snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For example, issue the following Tivoli Storage
Manager administrative command:
backup db type=dbsnapshot devclass=tapeclass

See the Administrator's Guide for more details.
5. Back up the device configuration information. Issue the following Tivoli

Storage Manager administrative command:
backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

6. Save the volume history file to another directory or rename the file. Issue the
following Tivoli Storage Manager administrative command:
backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

7. Save a copy of the server options file, typically named dsmserv.opt. The file is
in the server instance directory.

8. Halt the server before installing a fix pack or interim fix. Use the HALT
command.

9. Ensure that extra space is available in the installation directory. The
installation of this fix pack might require additional temporary disk space in
the installation directory of the server. The amount of additional disk space
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can be as much as that required for installing a new database as part of a
Tivoli Storage Manager installation. The Tivoli Storage Manager installation
wizard displays the amount of space that is required for installing the fix pack
and the available amount. If the required amount of space is greater than the
available amount, the installation stops. If the installation stops, add the
required disk space to the file system and restart the installation.

10. Select one of the following ways of installing Tivoli Storage Manager.

Important: After a fix pack is installed, it is not necessary to go through the
configuration again. You can stop after completing the installation, fix any
errors, then restart your servers.
Install the Tivoli Storage Manager software by using one of the following
methods:

Installation wizard
Follow the instructions for your operating system:

“Installing Tivoli Storage Manager by using the installation wizard”
on page 35

Tip: After you start the wizard, in the IBM Installation Manager window,
click the Update icon; do not click the Install or Modify icon.

Command line in console mode
Follow the instructions for your operating system:

“Installing Tivoli Storage Manager by using console mode” on page 36

Silent mode
Follow the instructions for your operating system:

“Installing Tivoli Storage Manager in silent mode” on page 37

Tip: If you have multiple server instances on your system, run the installation
wizard only once. The installation wizard upgrades all server instances.

Results

If errors occur during the installation process, these errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the Installation
Manager tool. To collect these log files, click Help > Export Data for Problem
Analysis from the Installation Manager tool.
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Chapter 5. Upgrading to Tivoli Storage Manager Version 7.1

You can upgrade a Tivoli Storage Manager V5 or V6 server to V7.1. If a V5 server
is installed on an AIX, HP-UX, Solaris, or z/OS operating system, you can
complete a cross-platform migration to V7.1 on a different operating system.

About this task

To upgrade the server on the same operating system, see the upgrade instructions:

Table 16. Upgrade information

To upgrade from this
version To this version See this information

V7.1 V7.1 fix pack or interim fix Chapter 4, “Installing a Tivoli
Storage Manager server fix
pack,” on page 65

V6.2 or V6.3 V7.1 “Upgrading from Tivoli
Storage Manager V6.2 or
V6.3 to V7.1” on page 70

V6.1 V7.1 “Upgrading from Tivoli
Storage Manager V6.1 to
V7.1” on page 77

V5.5 V7.1 Upgrade and Migration Guide
for V5 Servers

For information about upgrades in a clustered environment, see “Upgrading Tivoli
Storage Manager in a clustered environment” on page 78.

If a Tivoli Storage Manager V5 server is installed, and you prefer to upgrade the
server to V7 on a different operating system, see the instructions for server
migration:

Table 17. Migration information

To migrate the server from
this operating system To this operating system See this information

AIX Linux x86_64 Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers

HP-UX Linux x86_64 Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers
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Table 17. Migration information (continued)

To migrate the server from
this operating system To this operating system See this information

Solaris Linux x86_64 Section about migrating
Tivoli Storage Manager V5
servers on AIX, HP-UX, or
Solaris systems to V7.1 on
Linux in the Upgrade and
Migration Guide for V5 Servers

z/OS AIX Section about migrating
Tivoli Storage Manager V5
servers on z/OS systems to
V7 on AIX or Linux on
System z in the Upgrade and
Migration Guide for V5 Servers

z/OS Linux on System z Section about migrating
Tivoli Storage Manager V5
servers on z/OS systems to
V7 on AIX or Linux on
System z in the Upgrade and
Migration Guide for V5 Servers

To revert to an earlier version of Tivoli Storage Manager after an upgrade or
migration, you must have a full database backup and the installation software for
the original server. You must also have key configuration files:
v Volume history file
v Device configuration file
v Server options file
v dsmserv.dsk file (for a server upgrade or migration from V5 to V7.1)

Upgrading from Tivoli Storage Manager V6.2 or V6.3 to V7.1
You can upgrade the server directly from Tivoli Storage Manager V6.2 or V6.3 to
V7.1. You do not need to uninstall V6.2 or V6.3.

Before you begin

Ensure that you retain the installation media from the V6.2 or V6.3 server base
release that you are upgrading. If you installed Tivoli Storage Manager from a
DVD, ensure that the DVD is available. If you installed Tivoli Storage Manager
from a downloaded package, ensure that the downloaded files are available. If the
upgrade fails, and the server license module is uninstalled, the installation media
from the server base release are required to reinstall the license.

Procedure

To upgrade the server to V7.1, complete the following tasks:
1. “Planning the upgrade” on page 71
2. “Preparing the system” on page 72
3. “Installing the V7.1 server and verifying the upgrade” on page 74
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Planning the upgrade
Before you upgrade the server from V6.2 or V6.3 to V7.1, you must review the
relevant planning information, such as system requirements and release notes.
Then, select an appropriate day and time to upgrade the system so that you can
minimize the impact on production operations.

About this task

In lab tests, the process of upgrading the server from V6.2 or V6.3 to V7.1 took 14 -
45 minutes. The results that you achieve might differ, depending on your hardware
and software environment, and the size of the server database.

The following table shows the results that were obtained in lab tests.

Table 18. V6 to V7 upgrade times in lab tests

Version of
source
system

Version of
target system

Operating
system

Size of server
database

Random
access
memory Upgrade time

V6.3.4 V7.1 AIX 17 GB 64 GB 40 minutes

V6.3.4 V7.1 AIX 487 GB 32 GB 45 minutes

V6.3.4 V7.1 AIX 3.8 TB 64 GB 35 minutes

V6.2.5 V7.1 Linux 6.16 GB 16 GB 15 minutes

V6.3.4 V7.1 Linux 30 GB 16 GB 14 minutes

V6.2.5 V7.1 Linux 70 GB 16 GB 24 minutes

V6.3.4 V7.1 Linux 1.4 TB 64 GB 30 minutes

V6.2.5 V7.1 Solaris 9.43 GB 32 GB 35 minutes

V6.3.4 V7.1 Windows 2.35 TB 64 GB 45 minutes

Procedure
1. Review the hardware and software requirements:

“System requirements” on page 4
For the latest updates related to system requirements, see the Tivoli Storage
Manager support website at http://www.ibm.com/support/
docview.wss?uid=swg21243309.

2. For special instructions or specific information for your operating system,
review the release notes: http://publib.boulder.ibm.com/infocenter/tsminfo/
v7r1/topic/com.ibm.itsm.nav.doc/r_relnotes.html.

3. If the server that you are upgrading is at a release level that is earlier than
V6.2.3.000, review Technote 1452146 (http://www.ibm.com/support/
docview.wss?uid=swg21452146). The technote describes improvements in the
database reorganization process, and configuration changes that you might be
required to make.

4. Select an appropriate day and time to upgrade your system to minimize the
impact on production operations. The amount of time that is required to
update the system depends on the database size and many other factors. When
you start the upgrade process, clients cannot connect to the server until the
new software is installed and any required licenses are registered again.
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Preparing the system
To prepare the system for the upgrade from V6.2 or V6.3 to V7.1, you must gather
information about each DB2 instance. Then, back up the server database, save key
configuration files, cancel sessions, and stop the server.

Procedure
1. Log on to the computer where Tivoli Storage Manager is installed.

Ensure that you are logged on with the instance user ID.
2. Obtain a list of DB2 instances. Issue the following system command:

/opt/tivoli/tsm/db2/instance/db2ilist

The output might be similar to the following example:
tsminst1

Ensure that each instance corresponds to a server that is running on the
system.

3. For each DB2 instance, note the default database path, actual database path,
database name, database alias, and any DB2 variables that are configured for
the instance. Keep the record for future reference. This information is required
to restore the V6 database.
a. Obtain the default database path of the DB2 instance by issuing the

following system command:
. ~/sqllib/db2profile; LC_ALL=C db2 get dbm cfg | grep DFTDBPATH

The output might be similar to the following example:
Default database path (DFTDBPATH) = /tsminst1/tsminst1

Tip: If you are upgrading the server from V6.3, the default database path
is /tsminst1/tsminst1. If you are upgrading the server from V6.2, the
default database path is /home/tsminst1/tsminst1.

b. Obtain information about the DB2 instance databases by issuing the
following system command:
. ~/sqllib/db2profile; LC_ALL=C db2 list database directory

The output might be similar to the following example:
System Database Directory

Number of entries in the directory = 2

Database 1 entry:

Database alias = TSMAL001
Database name = TSMDB1
Node name = TSMNODE1
Database release level = d.00
Comment = TSM SERVER DATABASE VIA TCPIP
Directory entry type = Remote
Catalog database partition number = -1
Alternate server hostname =
Alternate server port number =

Database 2 entry:

Database alias = TSMDB1
Database name = TSMDB1
Local database directory = /tsminst1/tsminst1
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Database release level = d.00
Comment = TSM SERVER DATABASE
Directory entry type = Indirect
Catalog database partition number = 0
Alternate server hostname =
Alternate server port number =

c. Obtain the DB2 instance variables by issuing the following system
command:
. ~/sqllib/db2profile; LC_ALL=C db2set -all

The output might be similar to the following example:
[i] DB2_PMODEL_SETTINGS=MAX_BACKGROUND_SYSAPPS:500
[i] DB2_SKIPINSERTED=ON
[i] DB2_KEEPTABLELOCK=OFF
[i] DB2_EVALUNCOMMITTED=ON
[i] DB2_SKIPDELETED=ON
[i] DB2COMM=TCPIP
[i] DB2CODEPAGE=819
[i] DB2_PARALLEL_IO=*
[g] DB2FCMCOMM=TCPIP6
[g] DB2SYSTEM=freeride.storage.tucson.ibm.com
[g] DB2INSTDEF=tsminst1inst

d. Obtain more DB2 instance information by saving the following files:
~/sqllib/userprofile

~/sqllib/usercshrc

For example, issue the following system commands:
cp ~/sqllib/userprofile copy_location

cp ~/sqllib/usercshrc copy_location

where copy_location is the location where the copied file is saved.
The file content might be similar to the following example:
setenv DSMI_CONFIG /tsminst1/tsminst1/tsmdbmgr.opt
setenv DSMI_DIR /opt/tivoli/tsm/client/bin64
setenv DSMI_LOG /tsminst1/tsminst1
setenv LD_LIBRARY_PATH /usr/local/ibm/gsk8_64/lib64:$LD_LIBRARY_PATH

4. Connect to the Tivoli Storage Manager server by using an administrative user
ID.

5. Back up the Tivoli Storage Manager database. For example, you can create a
snapshot backup by issuing the following Tivoli Storage Manager
administrative command:
backup db type=dbsnapshot devclass=tapeclass

A snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For more information about this command and
other Tivoli Storage Manager administrative commands, see the
Administrator's Reference.

6. Back up the device configuration information to another directory by issuing
the following Tivoli Storage Manager administrative command:
backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

Tip: If you decide to restore the V6 database, this file is required.
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7. Back up the volume history file to another directory. Issue the following Tivoli
Storage Manager administrative command:
backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

Tip: If you decide to restore the V6 database, this file is required.
8. Save a copy of the server options file, which is typically named dsmserv.opt.

The file is in the server instance directory.
9. Prevent activity on the server by disabling new sessions. Issue the following

Tivoli Storage Manager administrative commands:
disable sessions client
disable sessions server

10. Verify whether any sessions exist, and notify the users that the server will be
stopped. To check for existing sessions, issue the following Tivoli Storage
Manager administrative command:
query session

11. Cancel sessions by issuing the following Tivoli Storage Manager
administrative command:
cancel session all

This command cancels all sessions except for your current session.
12. Stop the server by issuing the following Tivoli Storage Manager

administrative command:
halt

13. Verify that the server is shut down and no processes are running.
Issue the following command:
ps -ef | grep dsmserv

14. In the server instance directory of your installation, locate the NODELOCK file
and move it to another directory, where you are saving configuration files.
The NODELOCK file contains the previous licensing information for your
installation. This licensing information is replaced when the upgrade is
complete.

Installing the V7.1 server and verifying the upgrade
To complete the process of upgrading the server from V6.2 or V6.3 to V7.1, you
must install the V7.1 server. Then, verify that the upgrade was successful by
starting the server instance.

Before you begin

You must be logged on to the system by using the root user ID.

You can obtain the installation package from the product DVD or from an IBM
download site.

If you plan to download the files, set the system user limit for maximum file size
to unlimited to ensure that the files can be downloaded correctly.
1. To query the maximum file size value, issue the following command:

ulimit -Hf
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2. If the system user limit for maximum file size is not set to unlimited, change it
to unlimited by following the instructions in the documentation for your
operating system.

About this task

By using the Tivoli Storage Manager installation software, you can install the
following components:
v Tivoli Storage Manager server
v Tivoli Storage Manager server languages
v Tivoli Storage Manager license
v Tivoli Storage Manager devices
v Tivoli Storage Manager Operations Center
v Tivoli Storage Manager storage agent

Tip: The database (DB2) and the Global Security Kit are automatically installed
when you select the server component.
For more information about storage agents, see the Storage Agent User's Guide.

Procedure
1. If you are obtaining the package from an IBM download site, download the

appropriate package file from one of the following websites:
v For a new release, go to Passport Advantage at http://www.ibm.com/

software/lotus/passportadvantage/. Passport Advantage is the only website
from which you can download a licensed package file.

v For a maintenance fix, go to the Tivoli Storage Manager support site at
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Manager.

2. If you are downloading the package from one of the download sites, complete
the following steps:

a. Verify that you have enough space to store the installation files
when they are extracted from the product package. For space
requirements, see the download document for your product:
v Tivoli Storage Manager: http://www.ibm.com/support/

docview.wss?uid=swg24035122
v Tivoli Storage Manager Extended Edition: http://www.ibm.com/

support/docview.wss?uid=swg24035635
v System Storage Archive Manager: http://www.ibm.com/

support/docview.wss?uid=swg24035637
b. Download the package file to the directory of your choice. The path

must contain no more than 128 characters. Be sure to extract the
installation files to an empty directory. Do not extract to a directory
that contains previously extracted files, or any other files.
Also, ensure that you have executable permission for the package
file.

c. If necessary, change the file permissions by issuing the following
command:
chmod a+x package_name.bin

where package_name is like the following example:
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7.1.0.000-TIV-TSMSRV-Linuxx86_64.bin
7.1.0.000-TIV-TSMSRV-Linuxs390x.bin

In the examples, 7.1.0.000 represents the product release level.
d. Extract the installation files by issuing the following command:

./package_name.bin

The package is large. Therefore, the extraction takes some time.
3. Install the Tivoli Storage Manager software by using one of the following

methods. During the installation process, you must install the Tivoli Storage
Manager license.

Installation wizard
To install the server by using the graphical wizard of IBM Installation
Manager, follow the instructions in “Installing Tivoli Storage Manager
by using the installation wizard” on page 35. Ensure that your system
meets the prerequisites for using the installation wizard. Then,
complete the installation procedure. In the IBM Installation Manager
window, click the Install icon; do not click the Update or Modify icon.

Tip: If you have multiple server instances on your system, run the
installation wizard only once. The installation wizard upgrades all
server instances.

Command line in console mode

To install the server by using the command line in console mode,
follow the instructions in “Installing Tivoli Storage Manager by using
console mode” on page 36.

Review the information about installing the server in console mode and
then complete the installation procedure.

Silent mode
To install the server in silent mode, follow the instructions in “Installing
Tivoli Storage Manager in silent mode” on page 37. Review the
information about installing the server in silent mode. Then, complete
Steps 1 and 2 of the installation procedure.

4. Correct any errors that are detected during the installation process. To view
installation log files, from the Installation Manager tool, click File > View Log.
To collect log files, from the Installation Manager tool, click Help > Export Data
for Problem Analysis.

5. Obtain any applicable fixes by going to the following website:
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Manager. Click Fixes (downloads) and apply any applicable
fixes.

6. Verify that the upgrade was successful:
a. Start the server instance. For instructions, see “Starting the server instance”

on page 55.
b. Monitor the messages that the server issues as it starts. Watch for error and

warning messages, and resolve any issues.
c. Verify that you can connect to the server by using the administrative client.

To start an administrative client session, issue the following Tivoli Storage
Manager administrative command:
dsmadmc
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d. To obtain information about the upgraded system, run QUERY commands.
For example, to obtain consolidated information about the system, issue the
following Tivoli Storage Manager administrative command:
query system

To obtain information about the database, issue the following Tivoli Storage
Manager administrative command:
query db format=detailed

7. Register the licenses for the Tivoli Storage Manager server components that are
installed on your system by issuing the REGISTER LICENSE command:
register license file=installation_directory/server/bin/component_name.lic

where installation_directory specifies the directory in which you installed the
component, and component_name specifies the abbreviation for the component.

For example, if you installed the server in the default directory,
/opt/tivoli/tsm, register the license by issuing the following command:
register license file=/opt/tivoli/tsm/server/bin/tsmbasic.lic

For example, if you installed Tivoli Storage Manager Extended Edition in the
/opt/tivoli/tsm directory, issue the following command:
register license file=/opt/tivoli/tsm/server/bin/tsmee.lic

For example, if you installed System Storage Archive Manager in the
/opt/tivoli/tsm directory, issue the following command:
register license file=/opt/tivoli/tsm/server/bin/dataret.lic

Restriction: You cannot register licenses for Tivoli Storage Manager for Mail,
Tivoli Storage Manager for Databases, Tivoli Storage Manager for ERP, and
Tivoli Storage Manager for Space Management.

8. Optional: To install an additional language package, use the modify function of
the IBM Installation Manager.

9. Optional: To upgrade to a newer version of a language package, use the update
function of the IBM Installation Manager.

What to do next

You can authenticate passwords with the LDAP directory server, or authenticate
passwords with the Tivoli Storage Manager server. Passwords that are
authenticated with the LDAP directory server can provide enhanced system
security. For instructions, see the section about managing passwords and logon
procedures in the Administrator's Guide.

Upgrading from Tivoli Storage Manager V6.1 to V7.1
You can upgrade the Tivoli Storage Manager server from V6.1 to V6.3, and then
upgrade the server to V7.1. It is not possible to upgrade the server directly from
V6.1 to V7.1.

Before you begin

Ensure that you retain the installation media from the base release of the V6.1 and
V6.3 servers. If you obtained the Tivoli Storage Manager software from a DVD,
ensure that the DVD is available. If you obtained the Tivoli Storage Manager
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software from a downloaded package, ensure that the downloaded files are
available. If the upgrade fails, and the server license module is uninstalled, the
installation media from the server base release are required to reinstall the license.

Procedure
1. Upgrade the server from V6.1 to V6.3. For instructions, go to the Tivoli Storage

Manager V6.3 Information Center at http://pic.dhe.ibm.com/infocenter/
tsminfo/v6r3. Follow the instructions for upgrading the server from V6.1 to
V6.3 or later.

2. Upgrade the server from V6.3 to V7.1, as described in “Upgrading from Tivoli
Storage Manager V6.2 or V6.3 to V7.1” on page 70.

Upgrading Tivoli Storage Manager in a clustered environment
To upgrade a Tivoli Storage Manager server to V7.1 in a clustered environment,
you must complete preparation and installation tasks. The procedures vary,
depending on the operating system and release.

Procedure

Follow the procedure for your operating system, source release, and target release:

Table 19. Procedures for upgrading the server in a clustered environment on a Linux
operating system

Source release Target release Procedure

V6 V7.1 “Upgrading Tivoli Storage
Manager to V7.1 in a
clustered environment”

Upgrading Tivoli Storage Manager to V7.1 in a clustered
environment

You can upgrade the Tivoli Storage Manager V6 server that is installed on a Linux
operating system in a clustered environment to Tivoli Storage Manager V7.1.

About this task

To upgrade the Tivoli Storage Manager server in a clustered environment on a
Linux system, review the upgrade steps in http://www.ibm.com/support/
docview.wss?uid=swg27039780.
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Chapter 6. Reverting from Version 7.1 to the previous V6
server

If you must revert to the previous version of the server after an upgrade, you must
have a full database backup from your original version. You must also have the
server installation media for your original version and key configuration files.
Carefully follow the preparation steps before you upgrade the server. By doing so,
it might be possible to revert to the previous version of the Tivoli Storage Manager
server with minimal loss of data.

Before you begin

You must have the following items from the earlier version of the server:
v Server database backup
v Volume history file
v Device configuration file
v Server options file

About this task

Use the same instructions whether you are reverting within releases or to an earlier
release, for example, from 6.2.2 to 6.2.0 or from 6.2.2 to 6.1.2. The older version
must match the version that you used before the upgrade to 7.1.

Attention: Specify the REUSEDELAY parameter to help prevent backup-archive
client data loss when you revert the server to a previous version.

Steps for reverting to the previous server version
About this task

Complete the following steps on the system that has the V7.1 server.

Procedure
1. Halt the server to shut down all server operations by using the HALT

command.
2. Remove the database from the database manager, then delete the database and

recovery log directories.
a. Manually remove the database. One way to remove it is by issuing this

command:
dsmserv removedb tsmdb1

b. If you must reuse the space that is occupied by the database and recovery
log directories, you can now delete these directories.

3. Use the uninstallation program to uninstall the V7.1 server. Uninstallation
removes the server and the database manager, with their directories. For
details, see Chapter 8, “Uninstalling Tivoli Storage Manager,” on page 87.

4. Reinstall the version of the server program that you were using before the
upgrade to V7.1. This version must match the version that your server was
running when you created the database backup that you restore in a later
step. For example, the server was at version 6.2.2.0 before the upgrade, and
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you intend to use the database backup that was in use on this server. You
must install the 6.2.2.0 fix pack to be able to restore the database backup.

5. Copy the following files to the instance directory.
v Device configuration file
v Volume history file
v The server options file (typically dsmserv.opt)

6. Configure the new server database by using the configuration wizard. To start
the wizard, issue the following command:
. /dsmicfgx

7. Ensure that no servers are running in the background.
8. Restore the database to a point in time before the upgrade. For more details,

see the restoring the server database to a point in time section in the
Administrator’s Guide.

9. If you enabled data deduplication for any FILE-type storage pools that existed
before the upgrade, or if you moved data that existed before the upgrade into
new storage pools while using the V7.1 server, you must complete additional
recovery steps. For more details, see “Additional recovery steps if you created
new storage pools or enabled data deduplication.”

10. If the REUSEDELAY parameter setting on storage pools is less than the age of the
database that you restored, restore volumes on any sequential-access storage
pools that were reclaimed after that database backup. Use the RESTORE VOLUME
command.
If you do not have a backup of a storage pool, audit the reclaimed volumes
by using the AUDIT VOLUME command, with the FIX=YES parameter to resolve
inconsistencies. For example:
audit volume volume_name fix=yes

11. If client backup or archive operations were completed using the V7.1 server,
audit the storage pool volumes on which the data was stored.

Additional recovery steps if you created new storage pools or enabled
data deduplication

If you created new storage pools, turned on data deduplication for any FILE-type
storage pools, or did both while your server was running as a V7.1 server, you
must complete more steps to return to the previous server version.

Before you begin

To complete this task, you must have a complete backup of the storage pool that
was created before the upgrade to V7.1.

About this task

Use this information if you did either or both of the following actions while your
server was running as a V7.1 server:
v You enabled the data deduplication function for any storage pools that existed

before the upgrade to V7.1 program. Data deduplication applies only to storage
pools that use a FILE device type.

v You created new, primary storage pools after the upgrade, and moved data that
was stored in other storage pools into the new storage pools.

Complete these steps after the server is again restored to V6.
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Procedure
v For each storage pool for which you enabled the data deduplication function,

restore the entire storage pool by using the RESTORE STGPOOL command.
v For storage pools that you created after the upgrade, determine what action to

take. Data that was moved from existing, V6 storage pools into the new storage
pools might be lost because the new storage pools no longer exist in your
restored V6 server. Possible recovery depends on the type of storage pool:
– If data was moved from V6 DISK-type storage pools into a new storage pool,

space that was occupied by the data that was moved was probably reused.
Therefore, you must restore the original, V6 storage pools, by using the
storage pool backups that were created before the upgrade to V7.1.
If no data was moved from V6 DISK-type storage pools into a new storage
pool, then audit the storage pool volumes in these DISK-type storage pools.

– If data was moved from V6 sequential-access storage pools into a new storage
pool, that data might still exist and be usable in storage pool volumes on the
restored V6 server. The data might be usable if the REUSEDELAY parameter for
the storage pool was set to a value that prevented reclamation while the
server was running as a V7.1 server. If any volumes were reclaimed while the
server was running as a V7.1 server, restore those volumes from storage pool
backups that were created before the upgrade to V7.1.
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Chapter 7. Reference: DB2 commands for Tivoli Storage
Manager server databases

Use this list as reference when you are directed to issue DB2 commands by IBM
support.

Purpose

After using the wizards to install and configure Tivoli Storage Manager, you
seldom need to issue DB2 commands. A limited set of DB2 commands that you
might use or be asked to issue are listed in Table 20. This list is supplemental
material only and is not a comprehensive list. There is no implication that a Tivoli
Storage Manager administrator will use it on a daily or ongoing basis. Samples of
some commands are provided. Details of output are not listed.

For a full explanation of the commands described here and of their syntax, see
http://pic.dhe.ibm.com/infocenter/db2luw/v10r5.

Table 20. DB2 commands

Command Description Example

db2icrt Creates DB2 instances in the home
directory of the instance owner.
Tip: The Tivoli Storage Manager
configuration wizard creates the instance
used by the server and database. After a
server is installed and configured through
the configuration wizard, the db2icrt
command is generally not used.

This utility is in the DB2DIR/instance
directory, where DB2DIR represents the
installation location where the current
version of the DB2 database system is
installed.

Manually create a Tivoli Storage Manager
instance. Enter the command on one line:

/opt/tivoli/tsm/db2/instance/
db2icrt -a server -s ese -u
instance_name instance_name

db2set Displays DB2 variables. List DB2 variables:

db2set

CATALOG DATABASE Stores database location information in the
system database directory. The database
can be located either on the local
workstation or on a remote database
partition server. The server configuration
wizard takes care of any catalog needed
for using the server database. Run this
command manually, after a server is
configured and running, only if something
in the environment changes or is
damaged.

Catalog the database:

db2 catalog database tsmdb1

CONNECT TO DATABASE Connects to a specified database for
command-line interface (CLI) use.

Connect to the Tivoli Storage Manager
database from a DB2 CLI:

db2 connect to tsmdb1

© Copyright IBM Corp. 1993, 2013 83

http://pic.dhe.ibm.com/infocenter/db2luw/v10r5


Table 20. DB2 commands (continued)

Command Description Example

GET DATABASE CONFIGURATION Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Show the configuration information for a
database alias:

db2 get db cfg for tsmdb1

Retrieve information in order to verify
settings such as database configuration,
log mode, and maintenance.

db2 get db config for tsmdb1
show detail

GET DATABASE MANAGER CONFIGURATION Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Retrieve configuration information for the
database manager:

db2 get dbm cfg

GET HEALTH SNAPSHOT Retrieves the health status information for
the database manager and its databases.
The information returned represents a
snapshot of the health state at the time
the command was issued. Tivoli Storage
Manager monitors the state of the
database using the health snapshot and
other mechanisms that are provided by
DB2. There might be cases where the
health snapshot or other DB2
documentation indicates that an item or
database resource might be in an alert
state. Such a case indicates that action
must be considered to remedy the
situation. Tivoli Storage Manager monitors
the condition and responds appropriately.
Not all declared alerts by the DB2
database are acted on.

Receive a report on DB2 health monitor
indicators:

db2 get health snapshot for
database on tsmdb1

GRANT (Database Authorities) Grants authorities that apply to the entire
database rather than privileges that apply
to specific objects within the database.

Grant access to the user ID itmuser:

db2 GRANT CONNECT ON DATABASE
TO USER itmuser
db2 GRANT CREATETAB ON DATABASE
TO USER itmuser

Reference: DB2 commands for Tivoli Storage Manager server databases
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Table 20. DB2 commands (continued)

Command Description Example

RUNSTATS Updates statistics about the characteristics
of a table and associated indexes or
statistical views. These characteristics
include number of records, number of
pages, and average record length.

To see a table, issue this utility after
updating or reorganizing the table.

A view must be enabled for optimization
before its statistics can be used to
optimize a query. A view that is enabled
for optimization is known as a statistical
view. Use the DB2 ALTER VIEW statement
to enable a view for optimization. Issue
the RUNSTATS utility when changes to
underlying tables substantially affect the
rows returned by the view.
Tip: The server configures DB2 to run the
RUNSTATS command as needed.

Update statistics on a single table.

db2 runstats on table
SCHEMA_NAME.TABLE_NAME
with distribution and sampled
detailed indexes all

SET SCHEMA Changes the value of the CURRENT SCHEMA
special register, in preparation for issuing
SQL commands directly through the DB2
CLI.
Tip: A special register is a storage area
that is defined for an application process
by the database manager. It is used to
store information that can be referenced in
SQL statements.

Set the schema for Tivoli Storage
Manager:

db2 set schema tsmdb1

START DATABASE MANAGER Starts the current database manager
instance background processes. The Tivoli
Storage Manager server starts and stops
the instance and database whenever the
server starts and halts.
Important: Allow the Tivoli Storage
Manager server to manage the starting
and stopping of the instance and database
unless otherwise directed by IBM support.

Start the database manager:

db2start

STOP DATABASE MANAGER Stops the current database manager
instance. Unless explicitly stopped, the
database manager continues to be active.
This command does not stop the database
manager instance if any applications are
connected to databases. If there are no
database connections, but there are
instance attachments, the command forces
the instance attachments to stop first.
Then, it stops the database manager. This
command also deactivates any
outstanding database activations before
stopping the database manager.

This command is not valid on a client.

The Tivoli Storage Manager server starts
and stops the instance and database
whenever the server starts and halts.
Important: Allow the Tivoli Storage
Manager server to manage the starting
and stopping of the instance and database
unless otherwise directed by IBM support.

Stop the database manager:

db2 stop dbm

Reference: DB2 commands for Tivoli Storage Manager server databases
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Chapter 8. Uninstalling Tivoli Storage Manager

You can use the following procedures to uninstall Tivoli Storage Manager. Before
you remove Tivoli Storage Manager, ensure that you do not lose your backup and
archive data.

Before you begin

Complete the following steps before you uninstall Tivoli Storage Manager:
v Complete a full database backup.
v Save a copy of the volume history and device configuration files.
v Store the output volumes in a safe location.

About this task

You can uninstall Tivoli Storage Manager by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

“Uninstalling Tivoli Storage Manager by using a graphical wizard”

“Uninstalling Tivoli Storage Manager in console mode” on page 88

“Uninstalling Tivoli Storage Manager in silent mode” on page 88

What to do next

See Chapter 2, “Installing the Tivoli Storage Manager server components,” on page
33 for installation steps to reinstall the Tivoli Storage Manager components.

Uninstalling Tivoli Storage Manager by using a graphical wizard
You can uninstall Tivoli Storage Manager by using the IBM Installation Manager
installation wizard.

Procedure
1. Start the Installation Manager.

In the directory where the Installation Manager is installed, go to the eclipse
subdirectory (for example, /opt/IBM/InstallationManager/eclipse), and issue
the following command:
./IBMIM

2. Click Uninstall.
3. Select IBM Tivoli Storage Manager server, and click Next.
4. Click Uninstall.
5. Click Finish.
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Uninstalling Tivoli Storage Manager in console mode
To uninstall Tivoli Storage Manager by using the command line, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameter for console mode.

Procedure
1. In the directory where IBM Installation Manager is installed, go to the

following subdirectory:
eclipse/tools

For example:
/opt/IBM/InstallationManager/eclipse/tools

2. From the tools directory, issue the following command:
./imcl -c

3. To uninstall, enter 5.
4. Choose to uninstall from the IBM Tivoli Storage Manager package group.
5. Enter N for Next.
6. Choose to uninstall the IBM Tivoli Storage Manager server package.
7. Enter N for Next.
8. Enter U for Uninstall.
9. Enter F for Finish.

Uninstalling Tivoli Storage Manager in silent mode
To uninstall Tivoli Storage Manager in silent mode, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameters for silent mode.

Before you begin

The input directory, which is in the directory where the installation package is
extracted, contains the following sample response files for installing, updating, and
uninstalling the server:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

You can use these sample files as they are with the default values, or you can
customize them to suit your needs.

Procedure
1. In the directory where IBM Installation Manager is installed, go to the

following subdirectory:
eclipse/tools

For example:
/opt/IBM/InstallationManager/eclipse/tools

2. From the tools directory, issue the following command, where response_file
represents the response file path, including the file name:

./imcl -input response_file -silent

Uninstalling Tivoli Storage Manager
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The following command is an example:

./imcl -input /tmp/input/uninstall_response.xml -silent

Uninstalling and reinstalling Tivoli Storage Manager
If you plan to manually reinstall Tivoli Storage Manager instead of using the
wizard, there are a number of steps to take to preserve your server instance names
and database directories. During an uninstallation, any server instances previously
set up are removed, but the database catalogs for those instances still exist.

About this task

If you are using the wizard to upgrade from Tivoli Storage Manager Version 6.2 or
Version 6.3, it is not necessary to complete these steps, the wizard completes them
automatically. To manually uninstall and reinstall Tivoli Storage Manager, complete
the following steps:
1. Make a list of your current server instances before proceeding to the

uninstallation. Run the following command:
/opt/tivoli/tsm/db2/instance/db2ilist

2. Run the following commands for every server instance:
db2 attach to instance_name
db2 get dbm cfg show detail
db2 detach

Keep a record of the database path for each instance.
3. Uninstall Tivoli Storage Manager. See Chapter 8, “Uninstalling Tivoli Storage

Manager,” on page 87.
4. When you uninstall any version of Tivoli Storage Manager 6.1 or later,

including a fix pack, an instance file is created. The instance file is created to
help reinstall Tivoli Storage Manager. Check this file and use the information
when you are prompted for the instance credentials when reinstalling. In silent
installation mode, you provide these credentials using the INSTANCE_CRED
variable.
You can find the instance file in the following location:

/etc/tivoli/tsm/instanceList.obj

5. Reinstall Tivoli Storage Manager. See Chapter 2, “Installing the Tivoli Storage
Manager server components,” on page 33.

6. Recreate your server instances. See “Creating the server instance” on page 47.

Tip: The installation wizard configures the server instances but you must
verify that they exist. If they do not exist, you must manually configure them.

7. Catalog the database. Log in to each server instance as the instance user, one at
a time, and issue the following commands:
db2 catalog database tsmdb1
db2 attach to instance_name
db2 update dbm cfg using dftdbpath instance_directory
db2 detach

8. Verify that the server instance was created successfully. Issue this command:
/opt/tivoli/tsm/db2/instance/db2ilist

Uninstalling Tivoli Storage Manager

Chapter 8. Uninstalling Tivoli Storage Manager 89



9. Verify that Tivoli Storage Manager recognizes the server instance by listing
your directories. Your home directory appears if you did not change it. Your
instance directory does appear if you used the configuration wizard. Issue this
command:
db2 list database directory

If you see TSMDB1 listed, you can start the server.

Uninstalling Tivoli Storage Manager
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Part 2. Installing and upgrading Tivoli Monitoring for Tivoli
Storage Manager

IBM Tivoli Monitoring for Tivoli Storage Manager is not delivered with Tivoli
Storage Manager V7.1.

About this task

You can use Tivoli Monitoring for Tivoli Storage Manager Version 6.3.4 with any
Tivoli Storage Manager Version 5.5 or later server. For more information about
installing and configuring Tivoli Monitoring for Tivoli Storage Manager, see
Technote 1649883 at: http://www.ibm.com/support/
docview.wss?uid=swg21649883.
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Part 3. Installing and upgrading the Operations Center

The IBM Tivoli Storage Manager Operations Center is the web-based interface for
managing your storage environment.

Before you begin

Before you install and configure the Operations Center, review the following
information:
v “System requirements for the Operations Center” on page 95

– “Operations Center computer requirements” on page 96
– “Hub and spoke server requirements” on page 96
– “Operating system requirements” on page 99
– “Web browser requirements” on page 100
– “Language requirements” on page 100

v “Administrator IDs that the Operations Center requires” on page 101
v “IBM Installation Manager” on page 102
v “Installation checklist” on page 102
v “Obtaining the Operations Center installation package” on page 105

About this task

Table 21 lists the methods for installing or uninstalling the Operations Center and
indicates where to find the associated instructions.

For information about upgrading the Operations Center, see Chapter 11,
“Upgrading the Operations Center,” on page 109.

Table 21. Methods for installing or uninstalling the Operations Center

Method Instructions

Graphical wizard v “Installing the Operations Center by using a graphical
wizard” on page 106

v “Uninstalling the Operations Center by using a graphical
wizard” on page 125

Console mode v “Installing the Operations Center in console mode” on page
106

v “Uninstalling the Operations Center in console mode” on
page 125

Silent mode v “Installing the Operations Center in silent mode” on page 106

v “Uninstalling the Operations Center in silent mode” on page
126
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Chapter 9. Planning to install the Operations Center

Before you install the Operations Center, you must understand the system
requirements, the administrator IDs that the Operations Center requires, and the
information that you must provide to the installation program.

About this task

From the Operations Center, you can manage the following primary aspects of the
storage environment:
v Tivoli Storage Manager servers and clients
v Services such as backup and restore, archive and retrieve, and migrate and recall
v Storage pools and storage devices

The Operations Center includes the following features:

User interface for multiple servers
You can use the Operations Center to manage one or more Tivoli Storage
Manager servers.

In an environment with multiple Tivoli Storage Manager servers, you can
designate one Tivoli Storage Manager server as a hub server and the others
as spoke servers. The hub server can receive alerts and status information
from the spoke servers and present the information in a consolidated view
in the Operations Center.

Alert monitoring

An alert is a notification of a relevant problem on the Tivoli Storage
Manager server and is triggered by a Tivoli Storage Manager server
message. You can define which server messages trigger alerts, and only
those messages are reported as alerts in the Operations Center or in an
email.

This alert monitoring can help you identify and track relevant problems on
the Tivoli Storage Manager server.

Convenient command-line interface
The Operations Center includes a command-line interface for advanced
features and configuration.

System requirements for the Operations Center
Before you install the Operations Center, ensure that your system meets the
minimum requirements.

Use the Operations Center System Requirements Calculator to estimate the system
requirements for running the Operations Center and the hub and spoke servers
that are monitored by the Operations Center.

Requirements that are verified during the installation

Table 22 on page 96 lists the prerequisite requirements that are verified during the
installation and indicates where to find more information about these
requirements.

© Copyright IBM Corp. 1993, 2013 95

http://www.ibm.com/support/docview.wss?uid=swg21641684


Table 22. Requirements that are verified during the installation

Requirement Details

Minimum memory requirement “Operations Center computer requirements”

Operating system requirement “Operating system requirements” on page
99

Host name for the computer where the
Operations Center will be installed

“Installation checklist” on page 102

Requirements for the Operations Center
installation directory

“Installation checklist” on page 102

Operations Center computer requirements
You can install the Operations Center on the same computer as a Tivoli Storage
Manager server or on a different computer. If you install the Operations Center on
the same computer as a Tivoli Storage Manager server, that computer must meet
the system requirements for both the Operations Center and the Tivoli Storage
Manager server.

Resource requirements

The following resources are required to run the Operations Center:
v One processor core
v 4 GB of memory
v 1 GB of disk space

The hub and spoke servers that are monitored by the Operations Center require
additional resources, as described in “Hub and spoke server requirements.”

Hub and spoke server requirements
When you open the Operations Center for the first time, you must associate the
Operations Center with a Tivoli Storage Manager server that is designated as the
hub server. In a multiple-server environment, you can connect the other servers,
called spoke servers, to the hub server.

The spoke servers send alerts and status information to the hub server. The
Operations Center shows you a consolidated view of alerts and status information
for the hub server and any spoke servers.

If only one Tivoli Storage Manager server is monitored by the Operations Center,
that server is still called a hub server, even though no spoke servers are connected
to it.

Table 23 on page 97 indicates the version of Tivoli Storage Manager server that
must be installed on the hub server and on each spoke server that is managed by
the Operations Center.

Planning to install the Operations Center
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Table 23. Tivoli Storage Manager server version requirements for hub and spoke servers

Operations Center
Tivoli Storage Manager on the
hub server

Tivoli Storage Manager on
each spoke server

V7.1 V7.1 or later V6.3.4 or later

Tip: Some Operations Center
function is not available for
servers that use a version
earlier than V7.1.

Number of spoke servers that a hub server can support

The number of spoke servers that a hub server can support is dependent on the
configuration and on the version of Tivoli Storage Manager on each spoke server.
However, a general guideline is that a hub server can support 10 - 20 V6.3.4 spoke
servers but can support more V7.1 spoke servers.

Tips for designing the hub and spoke server configuration
In designing the hub and spoke configuration, especially consider the resource
requirements for status monitoring. Also, consider how you want to group hub
and spoke servers and whether you want to use multiple hub servers.

Use the Operations Center System Requirements Calculator to estimate the system
requirements for running the Operations Center and the hub and spoke servers
that are monitored by the Operations Center.

Primary factors that affect performance

The following factors have the most significant impact on the performance of the
Operations Center:
v The processor and memory on the computer where the Operations Center is

installed
v The system resources of the hub and spoke servers, including the disk system

that is in use for the hub server database
v The number of Tivoli Storage Manager client nodes and virtual machine file

spaces that are managed by the hub and spoke servers
v The frequency at which data is refreshed in the Operations Center

For information about optimizing performance, see the information about tuning
the Operations Center in Tivoli Storage Manager Optimizing Performance.

How to group hub and spoke servers

Consider grouping hub and spoke servers by geographic location. For example,
managing the servers within the same data center can help prevent issues that are
caused by firewalls or by inadequate network bandwidth between different
locations. If necessary, you can further divide servers according to one or more of
the following characteristics:
v The administrator who manages the servers
v The organizational entity that funds the servers
v Server operating system
v The language in which the servers run

Planning to install the Operations Center
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Tip: If the hub and spoke servers are not running in the same language, you
might see corrupted text in the Operations Center.

When to use multiple hub servers

If you have more than 10 - 20 V6.3.4 spoke servers, or if resource limitations
require the environment to be partitioned, you can configure multiple hub servers,
and connect a subset of the spoke servers to each hub server.

Restrictions:

v A single server cannot be both a hub server and a spoke server.
v Each spoke server can be assigned to only one hub server.
v Each hub server requires a separate instance of the Operations Center, each of

which has a separate web address.

Tips for choosing a hub server
For the hub server, you must choose a Tivoli Storage Manager server that has
adequate resources and is located for minimal roundtrip network latency.

For more information about server resource usage and about the effect of the
network on performance, see the information about tuning Operations Center
performance in Tivoli Storage Manager Optimizing Performance.

Attention: Do not use the same Tivoli Storage Manager server as the hub server
for multiple Operations Centers.

Use the following guidelines in deciding which server to designate as the hub
server:

Choose a lightly loaded server
Consider a Tivoli Storage Manager server that has a light load for Tivoli
Storage Manager operations such as client backup and archive. A lightly
loaded server is also a good choice as the host system for the Operations
Center.

Ensure that the server has the resources to handle both its typical Tivoli
Storage Manager server workload and the estimated workload for acting as
the hub server.

Locate the server for minimal roundtrip network latency
Locate the hub server so that the network connection between the hub
server and the spoke servers has a roundtrip latency that is no greater than
5 ms. This latency can typically be achieved when the servers are on the
same local area network (LAN).

Networks that are poorly tuned, are heavily used by other applications, or
have roundtrip latency much higher than 5 ms can degrade
communications between the hub and spoke servers. For example,
roundtrip latencies of 50 ms or higher can result in communication
timeouts that cause spoke servers to disconnect or reconnect to the
Operations Center. Such high latencies might be experienced in
long-distance, wide area network (WAN) communications.

If spoke servers are a long distance from the hub server and experience
frequent disconnects in the Operations Center, you can increase the value
of the ADMINCOMMTIMEOUT option on each server to reduce the problem.
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Verify that the hub server meets the resource requirements for status monitoring
Status monitoring requires extra resources on each server on which it is
enabled. The resources that are required depend primarily on the number
of clients that are managed by the hub and spoke servers. Fewer resources
are used on a hub server with a V7.1 spoke server than on a hub server
with a V6.3.4 spoke server.

Verify that the hub server meets the resource requirements for processor
usage, database space, archive log space, and I/O operations per second
(IOPS) capacity.

A hub server with high IOPS capacity can handle a larger amount of
incoming status data from spoke servers. Use of the following storage
devices for the hub server database can help meet this capacity:
v An enterprise-level solid-state drive (SSD)
v An external SAN disk storage device with multiple volumes or multiple

spindles under each volume

In an environment with fewer than 1000 clients, consider establishing a
baseline capacity of 1000 IOPS for the hub server database if the hub
server manages any spoke servers.

Determine whether your environment requires multiple hub servers
If more than 10,000 - 20,000 client nodes and virtual machine file spaces
are managed by one set of hub and spoke servers, the resource
requirements might exceed what the hub server has available, especially if
the spoke servers are Tivoli Storage Manager V6.3.4 servers. Consider
designating a second server as a hub server and moving spoke servers to
the new hub server to balance the load.

Operating system requirements
The Operations Center is available for AIX, Linux, and Windows systems.

You can run the Operations Center on the following systems:
v Linux x86_64 and IBM System z systems:

– Red Hat Enterprise Linux 5, update 6 or later
– Red Hat Enterprise Linux 6, all updates
– SUSE Linux Enterprise Server 10, Service Pack 3 or later
– SUSE Linux Enterprise Server 11, all updates

Although you cannot run the Operations Center on HP-UX or Oracle Solaris
systems, you can use the Operations Center to manage Tivoli Storage Manager
V6.3.4 or later servers that run on any supported server operating system.

The operating systems on which the server can run are not limited to those on
which the Operations Center can run.
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Web browser requirements
The Operations Center can run in Apple, Google, Microsoft, and Mozilla web
browsers.

For optimal viewing of the Operations Center in the web browser, ensure that the
screen resolution for the system is set to a minimum of 1024 X 768 pixels.

For optimal performance, use a web browser that has good JavaScript
performance, and enable browser caching.

The Operations Center can run in the following web browsers:
v Apple Safari on the iPad
v Google Chrome
v Microsoft Internet Explorer 9 and 10
v Mozilla Firefox ESR 10 or later

Language requirements
By default, the Operations Center uses the language that the web browser uses.
However, the installation process uses the language that the operating system uses.
Verify that the web browser and the operating system are set to the language that
you require.

Table 24. Operations Center language values that you can use on Linux systems

Language Language option value

Chinese, Simplified zh_CN

Chinese, Simplified (GBK) zh_CN.gb18030

Chinese, Simplified (UTF-8) zh_CN.utf8

Chinese, Traditional (Big5) Zh_TW

Chinese, Traditional (euc_tw) zh_TW

Chinese, Traditional (UTF-8) zh_TW.utf8

English, United States en_US

English (UTF-8) en_US.utf8

French fr_FR

French (UTF-8) fr_FR.utf8

German de_DE

German (UTF-8) de_DE.utf8

Italian it_IT

Italian (UTF-8) it_IT.utf8

Japanese (EUC) ja_JP

Japanese (UTF-8) ja_JP.utf8

Korean ko_KR

Korean (UTF-8) ko_KR.utf8

Portuguese, Brazilian pt_BR

Portuguese, Brazilian (UTF-8) pt_BR.utf8

Russian ru_RU

Russian (UTF-8) ru_RU.utf8
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Table 24. Operations Center language values that you can use on Linux
systems (continued)

Language Language option value

Spanish es_ES

Spanish (UTF-8) es_ES.utf8

Administrator IDs that the Operations Center requires
An administrator must have a valid ID and password on the hub server to log in
to the Operations Center. An administrator ID is also assigned to the Operations
Center so that the Operations Center can monitor servers.

The Operations Center requires the following Tivoli Storage Manager administrator
IDs:

Administrator IDs that are registered on the hub server
Any administrator ID that is registered on the hub server can be used to
log in to the Operations Center. The authority level of the ID determines
which tasks can be completed. You can create new administrator IDs by
using the REGISTER ADMIN command.

Restriction: To use an administrator ID in a multiple-server configuration,
the ID must be registered on the hub and spoke servers with the same
password and authority level.

To manage authentication for these servers, consider using one of the
following methods:
v A Lightweight Directory Access Protocol (LDAP) server
v The Tivoli Storage Manager enterprise configuration functions to

automatically distribute changes to the administrator definitions.
For more information about the enterprise configuration functions, see
the information about managing a network of Tivoli Storage Manager
servers in the Administrator's Guide.

Monitoring administrator ID
When you initially configure the hub server, an administrator ID named
IBM-OC-server_name is registered with system authority on the hub server
and is associated with the initial password that you specify. This ID, which
is sometimes called the monitoring administrator, is intended for use only by
the Operations Center.

Do not delete, lock, or modify this ID. The same administrator ID with the
same password is registered on the spoke servers that you add. The
password is automatically changed on the hub and spoke servers every 90
days. You do not need to use or manage this password.
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IBM Installation Manager
The Operations Center uses IBM Installation Manager, which is an installation
program that can use remote or local software repositories to install or update
many IBM products.

If the required version of IBM Installation Manager is not already installed, it is
automatically installed or upgraded when you install the Operations Center. It
must remain installed on the system so that the Operations Center can be updated
or uninstalled later as needed.

The following list contains explanations of some terms that are used in IBM
Installation Manager:

Offering
An installable unit of a software product.

The Operations Center offering contains all of the media that IBM
Installation Manager requires to install the Operations Center.

Package
The group of software components that are required to install an offering.

The Operations Center package contains the following components:
v IBM Installation Manager installation program
v Operations Center offering

Package group
A set of packages that share a common parent directory.

The default package group for the Operations Center package is IBM
Tivoli Storage Manager.

Repository
A remote or local storage area for data and other application resources.

The Operations Center package is stored in a repository on IBM Fix
Central.

Shared resources directory
A directory that contains software files or plug-ins that are shared by
packages.

IBM Installation Manager stores installation-related files in the shared
resources directory, including files that are used for rolling back to a
previous version of the Operations Center.

Installation checklist
Before you install the Operations Center, you must verify certain information, such
as the installation credentials, and you must determine the input to provide to IBM
Installation Manager for the installation.

The following checklist highlights the information that you must verify or
determine before you install the Operations Center, and Table 25 on page 103
describes the details of this information:
__ Verify the host name for the computer where the Operations Center will be

installed.
__ Verify the installation credentials.
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__ Determine the Operations Center installation directory, if you do not want to
accept the default path.

__ Determine the IBM Installation Manager installation directory, if you do not
want to accept the default path.

__ Determine the port number to be used by the Operations Center web server,
if you do not want to accept the default port number.

__ Determine the password for secure communications.

Table 25. Information to verify or determine before you install the Operations Center

Information Details

Host name for the computer where the
Operations Center will be installed

The host name must meet the following criteria:

v It must not contain double-byte character set (DBCS) characters or
the underscore character (_).

v Although the host name can contain the hyphen character (-), it
cannot have a hyphen as the last character in the name.

Installation credentials To install the Operations Center, you must use the following user
account:

v root

Operations Center installation directory The Operations Center is installed in the ui subdirectory of the
installation directory.

The following path is the default path for the Operations Center
installation directory:

v /opt/tivoli/tsm

For example, if you use this default path, the Operations Center is
installed in the following directory:

/opt/tivoli/tsm/ui

The installation directory path must meet the following criteria:

v The path must contain no more than 128 characters.

v The path must include only ASCII characters.

v The path cannot include non-displayable control characters.

v The path cannot include any of the following characters:

% | < > ’ " $ & ; *

IBM Installation Manager installation
directory

The following path is the default path for the IBM Installation
Manager installation directory:

v /opt/IBM/InstallationManager
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Table 25. Information to verify or determine before you install the Operations Center (continued)

Information Details

Port number that is used by the Operations
Center web server

The value for the secure (https) port number must meet the
following criteria:

v The number must be an integer in the range 1024 - 65535.

v The number cannot be in use or allocated to other programs.

If you do not specify a port number, the default value is 11090.

Tip: If you later do not remember the port number that you
specified, refer to the following file, where installation_dir
represents the directory where the Operations Center is installed:

v installation_dir/ui/Liberty/usr/servers/guiServer/
bootstrap.properties

The bootstrap.properties file contains the Tivoli Storage Manager
server connection information.

Password for secure communications The Operations Center uses Hypertext Transfer Protocol Secure
(HTTPS) to communicate with web browsers. You can optionally
use the Secure Sockets Layer (SSL) protocol to secure
communications between the Operations Center and the hub server,
and between Tivoli Storage Manager servers.

The truststore file of the Operations Center contains the SSL
certificate that the Operations Center uses for HTTPS
communication with web browsers. During installation of the
Operations Center, you create a password for the truststore file.

Tip: If you later choose to set up SSL communication between the
Operations Center and the hub server, you must use the same
password to add the SSL certificate of the hub server to the
truststore file.

The password for the truststore file must meet the following criteria:

v The password must contain a minimum of 6 characters and a
maximum of 64 characters.

v The password must contain at least the following characters:

– One uppercase letter (A – Z)

– One lowercase letter (a – z)

– One digit (0 – 9)

– Two of the following non-alphanumeric characters:

~ ! @ # $ % ^ & * _ - + = ` |

( ) { } [ ] : ; < > , . ? /

Related tasks:
“Configuring for SSL communication” on page 115
“Resetting the password for the Operations Center truststore file” on page 120
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Chapter 10. Installing the Operations Center

You can install the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

Before you begin

You cannot configure the Operations Center until you install, configure, and start
the Tivoli Storage Manager server. Therefore, before you install the Operations
Center, install the appropriate Tivoli Storage Manager server package, according to
the server version requirements in “Hub and spoke server requirements” on page
96.

You can install the Operations Center on a computer with the Tivoli Storage
Manager server or on a separate computer.

Obtaining the Operations Center installation package
You can obtain the installation package from the product DVD or from an IBM
download site such as IBM Passport Advantage or IBM Fix Central.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

Procedure

Use the following procedure to extract the Operations Center installation files:
v On Linux systems:

1. Download one of the following package files to the directory of your choice:
– 7.1.0.000-TIV-TSMOC-LinuxS390.bin

– 7.1.0.000-TIV-TSMOC-Linuxx64.bin

2. Ensure that you have executable permission for the package file.
If necessary, change the file permissions by issuing the following command:
chmod a+x package_name.bin

3. Issue the following command to extract the installation files:
./package_name.bin

The self-extracting package file is extracted to the directory.
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Installing the Operations Center by using a graphical wizard
You can install or update the Operations Center by using the graphical wizard of
IBM Installation Manager.

Procedure
1. From the directory where the Operations Center installation package file is

extracted, issue the following command:
./install.sh

2. Follow the wizard instructions to install the IBM Installation Manager and
Operations Center packages.

What to do next

See “Configuring the Operations Center” on page 111.

Installing the Operations Center in console mode
You can install or update the Operations Center by using the command line in
console mode.

Procedure
1. From the directory where the installation package file is extracted, run the

following program:
./install.sh -c

2. Follow the console instructions to install the Installation Manager and
Operations Center packages.

What to do next

See “Configuring the Operations Center” on page 111.

Installing the Operations Center in silent mode
You can install or update the Operations Center in silent mode. In silent mode, the
installation does not send messages to a console but instead stores messages and
errors in log files. A silent installation can use response files for data input.

Before you begin

The input directory, which is in the directory where the installation package is
extracted, contains the following sample response files for installing, updating, and
uninstalling the Operations Center:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

You can use these sample files as they are, with the default values, or you can
customize them.

Procedure
1. Create a response file, or use one of the following default response files:

v install_response_sample.xml
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v update_response_sample.xml

If you use a default response file, update the following line of the file to create
a password for the truststore file of the Operations Center, where mypassword
represents the password:
<data key=’user.SSL_PASSWORD’ value=’mypassword’/>

For more information about this password, see Installation checklist.
To generate a response file as part of a console-mode installation, complete the
selection of the console-mode installation options. Then, in the Summary panel,
enter G to generate the response file according to the previously selected
options.

2. From the directory where the installation package file is extracted, issue the
following command, where response_file represents the response file path,
including the file name:
v ./install.sh -s -input response_file -acceptLicense

What to do next

See “Configuring the Operations Center” on page 111.
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Chapter 11. Upgrading the Operations Center

You can upgrade the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

About this task

The instructions for upgrading the Operations Center are the same as the
instructions for installing the Operations Center, with the following exceptions:
v You use the Update function of IBM Installation Manager rather than the Install

function.

Tip: In IBM Installation Manager, the term update means to discover and install
updates and fixes to installed software packages. In this context, update and
upgrade are synonymous.

v If you are upgrading the Operations Center in silent mode, you can skip the
step of creating a password for the truststore file.

© Copyright IBM Corp. 1993, 2013 109



Upgrading the Operations Center

110 IBM Tivoli Storage Manager for Linux: Installation Guide



Chapter 12. Getting started with the Operations Center

Before you can use the Operations Center to manage your storage environment,
you must configure it.

About this task

After you install the Operations Center, complete the following basic configuration
steps:
1. Designate the hub server.
2. Add any spoke servers.
3. Optionally, configure email alerts on the hub and spoke servers.

Figure 3 illustrates an Operations Center configuration.

Configuring the Operations Center
When you open the Operations Center for the first time, you must configure it to
manage your storage environment. You must associate the Operations Center with
a Tivoli Storage Manager server that is designated as the hub server. You can then
connect additional Tivoli Storage Manager servers as spoke servers.

Hub server

Operations Center
(on hub server computer

or separate computer)

Spoke server

Spoke server

Spoke server

Spoke server

Hub server

S

S

S

S

Figure 3. Example of an Operations Center configuration with the hub and spoke servers
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Designating the hub server
When you connect to the Operations Center for the first time, you must designate
which Tivoli Storage Manager server is the hub server.

Procedure

In a web browser, enter the following address, where hostname represents the name
of the computer where the Operations Center is installed, and secure_port
represents the port number that the Operations Center uses for HTTPS
communication on that computer:
https://hostname:secure_port/oc

For more information about this port number, see Installation checklist.
Assuming that you are connecting to the Operations Center for the first time, you
must provide the following information:
v Connection information for the Tivoli Storage Manager server that you want to

designate as a hub server
v Login credentials for an administrator ID that is defined for that Tivoli Storage

Manager server

Tip: If the event-record retention period of the Tivoli Storage Manager server is
less than 14 days, the period is automatically reset to 14 days if you configure the
server as a hub server.

What to do next

If you have multiple Tivoli Storage Manager servers in your environment, add the
other Tivoli Storage Manager servers as spoke servers to the hub server.

Attention: Do not change the name of a Tivoli Storage Manager server after it is
configured as a hub or spoke server.
Related concepts:
“Hub and spoke server requirements” on page 96
“Administrator IDs that the Operations Center requires” on page 101

Adding a spoke server
After you configure the hub server for the Operations Center, you can add one or
more spoke servers to the hub server.

Procedure
1. In the Operations Center menu bar, click Servers. The TSM Servers page opens.

In the table on the TSM Servers page, a server might have a status of
“Unmonitored.” This status means that although an administrator defined this
server to the hub server by using the DEFINE SERVER command, the server is
not yet configured as a spoke server.

2. Complete one of the following steps:
v Click the server to highlight it, and in the table menu bar, click Monitor

Spoke.
v If the server that you want to add is not shown in the table, click Connect

Spoke in the table menu bar.
3. Provide the necessary information, and complete the steps in the spoke

configuration wizard.

Getting started with the Operations Center

112 IBM Tivoli Storage Manager for Linux: Installation Guide



Tip: If the event-record retention period of the Tivoli Storage Manager server is
less than 14 days, the period is automatically reset to 14 days if you configure
the server as a spoke server.

Sending email alerts to administrators
An alert is a notification of a relevant problem on the Tivoli Storage Manager
server and is triggered by a Tivoli Storage Manager server message. Alerts can be
shown in the Operations Center and can be sent from the server to administrators
by email.

Before you begin

Before you configure email notification for administrators about alerts, ensure that
the following requirements are met:
v An SMTP server is required to send and receive alerts by email, and the Tivoli

Storage Manager server that sends the alerts by email must have access to the
SMTP server.

Tip: If the Operations Center is installed on a separate computer, that computer
does not need access to the SMTP server.

v An administrator must have system privilege to configure email notification.

About this task

An email notification is sent only for the first occurrence of an alert. Also, if an
alert is generated before you configure email notification, no email notification is
sent for that alert.

You can configure email notification in the following ways:
v Send notification for individual alerts
v Send alert summaries

An alert summary contains information about current alerts. The summary
includes the total number of alerts, the total number of active and inactive alerts,
the oldest alert, the newest alert, and the most frequently occurring alert.

You can specify a maximum of three administrators to receive alert summaries by
email. Alert summaries are sent approximately every hour.

Procedure

To configure email notification for administrators about alerts, complete the
following steps on each hub and spoke server from which you want to receive
email alerts:
1. To verify that alert monitoring is turned on, issue the following command:

query monitorsettings

2. If the command output indicates that alert monitoring is turned off, issue the
following command. Otherwise, proceed to the next step.
set alertmonitor on

3. To enable the sending of email notification, issue the following command:
set alertemail on

4. To define the SMTP server that is used to send email notification, issue the
following command:
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set alertemailsmtphost host_name

5. To specify the port number for the SMTP server, issue the following command:
set alertemailsmtpport port_number

The default port number is 25.
6. To specify the email address of the sender of the alerts, issue the following

command:
set alertemailfromaddr email_address

7. For each administrator ID that must receive email notification, issue one of the
following commands to activate email notification and to specify the email
address:
register admin admin_name alert=yes emailaddress=email_address

update admin admin_name alert=yes emailaddress=email_address

8. Choose either, or both, of the following options, and specify the administrator
IDs to receive email notification:
v Send notification for individual alerts

To specify or update the administrator IDs to receive email notification for an
individual alert, issue one of the following commands:
define alerttrigger message_number ADmin=admin_name1,admin_name2

update alerttrigger message_number ADDadmin=admin_name3 DELadmin=admin_name1

v Send alert summaries
To specify or update the administrator IDs to receive alert summaries by
email, issue the following command:
set alertsummarytoadmins admin_name1,admin_name2,admin_name3

If you want to receive alert summaries but do not want to receive notification
about individual alerts, complete the following steps:
a. Suspend notification about individual alerts, as described in “Suspending

email alerts temporarily” on page 115.
b. Ensure that the respective administrator ID is listed in the following

command:
set alertsummarytoadmins admin_name1,admin_name2,admin_name3

Sending email alerts to multiple administrators

The following example illustrates the commands that cause any alerts for
ANR1075E messages to be sent in an email to the administrators myadmin, djadmin,
and csadmin:
set alertmonitor on
set alertmail on
set alertemailsmtphost mymailserver.domain.com
set alertemailsmtpport 450
set alertemailfromaddr srvadmin@mydomain.com
update admin myadmin alert=yes emailaddress=myaddr@anycompany.com
update admin djadmin alert=yes emailaddress=djaddr@anycompany.com
update admin csadmin alert=yes emailaddress=csaddr@anycompany.com
define alerttrigger anr0175e admin=myadmin,djadmin,csadmin
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Suspending email alerts temporarily
In certain situations, you might want to suspend email alerts temporarily. For
example, you might want to receive alert summaries but suspend notification
about individual alerts, or you might want to suspend email alerts when an
administrator is on vacation.

Before you begin

Configure email notification for administrators, as described in “Sending email
alerts to administrators” on page 113.

Procedure

Suspend email notification for individual alerts or for alert summaries.
v Suspend notification about individual alerts

Use either of the following methods:

UPDATE ADMIN command
To turn off email notification for the administrator, issue the following
command:
UPDATE ADMIN admin_name ALERT=NO

To turn on email notification again later, issue the following command:
UPDATE ADMIN admin_name ALERT=YES

UPDATE ALERTTRIGGER command
To prevent a specific alert from being sent to an administrator, issue the
following command:
UPDATE ALERTTRIGGER message_number DELADMIN=admin_name

To start sending that alert to the administrator again, issue the following
command:
UPDATE ALERTTRIGGER message_number ADDADMIN=admin_name

v Suspend notification about alert summaries
To prevent alert summaries from being sent to an administrator, remove the
administrator ID from the list in the following command:
set alertsummarytoadmins admin_name1,admin_name2,admin_name3

If an administrator ID is listed in the preceding command, the administrator
receives alert summaries by email, even if notification about individual alerts is
suspended for the respective administrator ID.

Configuring for SSL communication
The Operations Center uses Hypertext Transfer Protocol Secure (HTTPS) to
communicate with web browsers. You can optionally use the Secure Sockets Layer
(SSL) protocol to secure communications between the Operations Center and the
hub server, and between the hub server and associated spoke servers.
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Configuring for SSL communication between the Operations
Center and the hub server

To use the Secure Sockets Layer (SSL) protocol to secure communications between
the Operations Center and the hub server, you must add the SSL certificate of the
hub server to the truststore file of the Operations Center.

Before you begin

The truststore file of the Operations Center is a container for SSL certificates that
the Operations Center can access. The truststore file contains the SSL certificate that
the Operations Center uses for HTTPS communication with web browsers.

During the installation of the Operations Center, you create a password for the
truststore file. To set up SSL communication between the Operations Center and
the hub server, you must use the same password to add the SSL certificate of the
hub server to the truststore file. If you do not remember this password, you can
reset it. See “Resetting the password for the Operations Center truststore file” on
page 120.

Procedure
1. To ensure that SSL ports are set on the hub server, complete the following

steps:
a. From a Tivoli Storage Manager command line, issue the following

command to the hub server:
QUERY OPTION SSL*

The results include four server options, as shown in the following
example:

Server Option Option Setting
------------------------------
SSLTCPPort 3700
SSLTCPADMINPort 3800
SSLTLS12 No
SSLFIPSMODE No

b. If the SSLTCPPORT option has a value in the Option Setting column,
proceed to the next step. Otherwise, to assign a port value to this option,
edit the dsmserv.opt file of the hub server, and restart the hub server.

2. Note which certificate is set as the default certificate in the key database file of
the hub server. Also, note whether the SSLTLS12 option is set to YES or NO. In
step 16 on page 117, you must know the default certificate and the SSLTLS12
option value.

Tip: To verify the certificates in the key database file of the hub server, issue
the following command:
gsk8capicmd_64 -cert -list -db cert.kdb -stashed

3. If the SSLTLS12 option is set to YES, specify the cert256.arm certificate as the
default certificate in the key database file of the hub server.
The cert256.arm certificate must be used for SSL connections to the hub
server if the SSLTLS12 option is set to YES. To specify cert256.arm as the
default certificate, complete the following steps:
a. Issue the following command from the hub server instance directory:

gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed
-label "TSM Server SelfSigned SHA Key"
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b. Restart the hub server so that it can receive the changes to the key
database file.

4. Stop the Operations Center web server.
5. Go to the command line of the operating system on which the Operations

Center is installed.
6. Go to the following directory, where installation_dir represents the

directory in which the Operations Center is installed:
v installation_dir/ui/jre/bin

7. Open the IBM Key Management window by issuing the following command:
ikeyman

8. Click Key Database File > Open.
9. In the Open window, click Browse, and go to the following directory, where

installation_dir represents the directory in which the Operations Center is
installed:
v installation_dir/ui/Liberty/usr/servers/guiServer

10. In the guiServer directory, select the gui-truststore.jks file.
11. Click Open, and click OK.
12. Enter the password for the truststore file, and click OK.
13. In the Key database content area of the IBM Key Management window, click

the arrow, and select Signer Certificates from the list.
14. Click Add.
15. In the Open window, click Browse, and go to the hub server instance

directory, as shown in the following example:
v /opt/tivoli/tsm/server/bin

The directory contains the following SSL certificates:
v cert.arm

v cert256.arm

If you cannot access the hub server instance directory from the Open window,
complete the following steps:
a. Use FTP or another file-transfer method to copy the cert.arm and

cert256.arm files from the hub server to the following directory on the
computer where the Operations Center is installed:
v installation_dir/ui/Liberty/usr/servers/guiServer

b. In the Open window, go to the guiServer directory.
16. Select one of the two SSL certificates.

v Choose cert256.arm if the SSLTLS12 server option is set to YES. If the
SSLTLS12 option is set to YES, the Transport Layer Security (TLS) protocol
version 1.2 is used for communication.

v Choose cert.arm if the SSLTLS12 server option is set to NO. If the SSLTLS12
option is set to NO, the TLS protocol version 1.1 is used for communication.

Tip: The certificate that you choose must be set as the default certificate in the
key database file of the hub server. For more information, see step 2 on page
116 and step 3 on page 116.

17. Click Open, and click OK.
18. Enter a label for the certificate. For example, enter the name of the hub server.
19. Click OK. The SSL certificate of the hub server is added to the truststore file,

and the label is displayed in the Key database content area of the IBM Key
Management window.
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20. Close the IBM Key Management window.
21. Start the Operations Center web server.
22. To configure the Operations Center, complete the following steps in the login

window of the configuration wizard:
a. In the Connect to field, enter the value of one of the following server

options as the port number:
v SSLTCPPORT

v SSLTCPADMINPORT

Tip: If the SSLTCPADMINPORT option has a value, use that value. Otherwise,
use the value of the SSLTCPPORT option.

b. Select the Use SSL option.
If the Operations Center was previously configured, you can review the
contents of the serverConnection.properties file to verify the connection
information. The serverConnection.properties file is in the following
directory on the computer where the Operations Center is installed:
v installation_dir/ui/Liberty/usr/servers/guiServer

What to do next

To set up SSL communication between the hub server and a spoke server, see
“Configuring for SSL communication between the hub server and a spoke server.”

Configuring for SSL communication between the hub server
and a spoke server

To use the Secure Sockets Layer (SSL) protocol to secure communications between
the hub server and a spoke server, you must define the SSL certificate of the spoke
server to the hub server. You must also configure the Operations Center to monitor
the spoke server.

Before you begin

Ensure that the Operations Center is configured to use the SSL protocol for
communication between the Operations Center and the hub server.

Procedure
1. To ensure that SSL ports are correctly set on the hub server and each spoke

server, complete the following steps:
a. From a Tivoli Storage Manager command line, issue the following

command to each server:
QUERY OPTION SSL*

The results include four server options, as shown in the following
example:

Server Option Option Setting
------------------------------
SSLTCPPort 3700
SSLTCPADMINPort 3800
SSLTLS12 No
SSLFIPSMODE No
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b. If the SSLTCPPORT, SSLTCPADMINPORT, and SSLTLS12 options have values in
the Option Setting column, proceed to the next step. Otherwise, to assign
port values to these options, edit the dsmserv.opt file of the respective
server, and restart that server.
These options are required for all Tivoli Storage Manager servers that use
SSL. The options trigger the generation of the following files in the server
instance directory:
v cert.arm (SSL certificate)
v cert256.arm (SSL certificate)
v cert.kdb (key database file)

Restriction: Because server-to-server connections are not supported by the
cert.arm certificate, you must use the cert256.arm certificate.

2. On the spoke server, change to the directory of the spoke server instance.
3. To specify the required cert256.arm certificate as the default certificate in the

key database file of the spoke server, issue the following command:
gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed
-label "TSM Server SelfSigned SHA Key"

4. To verify the certificates in the key database file of the spoke server, issue the
following command:
gsk8capicmd_64 -cert -list -db cert.kdb -stashed

The following output is an example of the command output:
Certificates found
* default, - personal, ! trusted
! Entrust.net Secure Server Certification Authority
! Entrust.net Certification Authority (2048)
! Entrust.net Client Certification Authority
! Entrust.net Global Client Certification Authority
! Entrust.net Global Secure Server Certification Authority
! VeriSign Class 1 Public Primary Certification Authority
! VeriSign Class 2 Public Primary Certification Authority
! VeriSign Class 3 Public Primary Certification Authority
! VeriSign Class 1 Public Primary Certification Authority - G2
! VeriSign Class 2 Public Primary Certification Authority - G2
! VeriSign Class 3 Public Primary Certification Authority - G2
! VeriSign Class 4 Public Primary Certification Authority - G2
! VeriSign Class 1 Public Primary Certification Authority - G3
! VeriSign Class 2 Public Primary Certification Authority - G3
! VeriSign Class 3 Public Primary Certification Authority - G3
! VeriSign Class 3 Public Primary Certification Authority - G5
! VeriSign Class 4 Public Primary Certification Authority - G3
! VeriSign Class 3 Secure Server CA
! Thawte Primary Root CA
! Thawte Primary Root CA - G2 ECC
! Thawte Server CA
! Thawte Premium Server CA
! Thawte Personal Basic CA
! Thawte Personal Freemail CA
! Thawte Personal Premium CA
- TSM Server SelfSigned Key
*- TSM Server SelfSigned SHA Key

5. Securely transfer the cert256.arm file of the spoke server to the hub server.
6. On the hub server, change to the directory of the hub server instance.
7. To define the spoke server SSL certificate to the hub server, issue the following

command from the hub server instance directory, where spoke_servername is
the name of the spoke server, and spoke_cert256.arm is the file name of the
spoke server SSL certificate:
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gsk8capicmd_64 -cert -add -db cert.kdb -stashed -format ascii
-label spoke_servername -file spoke_cert256.arm

The spoke server does not require the hub server SSL certificate for
hub-to-spoke communication. However, other Tivoli Storage Manager server
configurations that require cross-defined servers do require the spoke server
to have the hub server SSL certificate.

Tip: From each server, you can view the certificates in the key database file
by issuing the following command:
gsk8capicmd_64 -cert -list -db cert.kdb -stashed

8. Restart the hub server and the spoke server.
9. For the hub server, issue the DEFINE SERVER command, according to the

following example:
DEFINE SERVER spoke_servername HLA=spoke_address
LLA=spoke_SSLTCPADMINPort SERVERPA=spoke_serverpassword SSL=YES

10. In the Operations Center menu bar, click Servers.
In the table on the TSM Servers page, the spoke server that you defined in
step 9 should have a status of “Unmonitored.” However, depending on the
setting for the status refresh interval, you might not see the spoke server
immediately.

11. Click the spoke server to highlight it, and in the table menu bar, click Monitor
Spoke.

Resetting the password for the Operations Center truststore
file

To set up SSL communication between the Operations Center and the hub server,
you must know the password for the truststore file of the Operations Center. You
create this password during the installation of the Operations Center. If you do not
know the password, you can reset it.

About this task

To reset the password, you must create a new password, delete the truststore file
of the Operations Center, and restart the Operations Center web server.

Procedure
1. Stop the Operations Center web server.
2. Go to the following directory, where installation_dir represents the directory

in which the Operations Center is installed:
installation_dir/ui/Liberty/usr/servers/guiServer

3. Open the bootstrap.properties file, which contains the password for the
truststore file. If the password is unencrypted, you can use it to open the
truststore file without having to reset it.
The following examples indicate the difference between an encrypted and an
unencrypted password:

Encrypted password example
Encrypted passwords begin with the text string {xor}.

The following example shows the encrypted password as the value of
the tsm.truststore.pswd parameter:
tsm.truststore.pswd={xor}MiYPPiwsKDAtOw==
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Unencrypted password example
The following example shows the unencrypted password as the value
of the tsm.truststore.pswd parameter:
tsm.truststore.pswd=J8b%^B

4. Reset the password by replacing the password in the bootstrap.properties file
with a new password. You can replace the password with an encrypted or
unencrypted password. Remember the unencrypted password for future use.
To create an encrypted password, complete the following steps:
a. Create an unencrypted password.

The password for the truststore file must meet the following criteria:
v The password must contain a minimum of 6 characters and a maximum

of 64 characters.
v The password must contain at least the following characters:

– One uppercase letter (A – Z)
– One lowercase letter (a – z)
– One digit (0 – 9)
– Two of the following non-alphanumeric characters:

~ ! @ # $ % ^ & * _ - + = ` |

( ) { } [ ] : ; < > , . ? /

b. From the command line of the operating system, go to the following
directory:

installation_dir/ui/Liberty/bin

c. To encrypt the password, issue the following command, where myPassword
represents the unencrypted password:

securityUtility encode myPassword

5. Close the bootstrap.properties file.
6. Go to the following directory:

installation_dir/ui/Liberty/usr/servers/guiServer

7. Delete the gui-truststore.jks file, which is the truststore file of the Operations
Center.

8. Start the Operations Center web server.

Results

A new truststore file is automatically created for the Operations Center, and the
SSL certificate of the Operations Center is automatically included in the truststore
file.

Starting and stopping the web server
The web server of the Operations Center runs as a service and starts automatically.
You might need to stop and start the web server, for example, to make
configuration changes.

Procedure

Stop and start the web server.
v Issue the following commands:

– To stop the server:
service opscenter.rc stop

Getting started with the Operations Center

Chapter 12. Getting started with the Operations Center 121



– To start the server:
service opscenter.rc start

– To restart the server:
service opscenter.rc restart

To determine whether the server is running, issue the following command:
service opscenter.rc status
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Chapter 13. Troubleshooting the Operations Center
installation

If a problem occurs with the Operations Center installation and you cannot solve
it, you can consult the descriptions of known problems for a possible solution.

Chinese, Japanese, or Korean fonts are displayed incorrectly
Chinese, Japanese, or Korean fonts are displayed incorrectly in the Operations
Center on Red Hat Enterprise Linux 5.

Solution

Install the following font packages, which are available from Red Hat:
v fonts-chinese
v fonts-japanese
v fonts-korean
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Chapter 14. Uninstalling the Operations Center

You can uninstall the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

Uninstalling the Operations Center by using a graphical wizard
You can uninstall the Operations Center by using the graphical wizard of IBM
Installation Manager.

Procedure
1. Open IBM Installation Manager.

In the directory where IBM Installation Manager is installed, go to the eclipse
subdirectory (for example, /opt/IBM/InstallationManager/eclipse), and issue
the following command:
./IBMIM

2. Click Uninstall.
3. Select IBM Tivoli Storage Manager Operations Center, and click Next.
4. Click Uninstall.
5. Click Finish.

Uninstalling the Operations Center in console mode
To uninstall the Operations Center by using the command line, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameter for console mode.

Procedure
1. In the directory where IBM Installation Manager is installed, go to the

following subdirectory:
eclipse/tools

For example:
/opt/IBM/InstallationManager/eclipse/tools

2. From the tools directory, issue the following command:
./imcl -c

3. To uninstall, enter 5.
4. Choose to uninstall from the IBM Tivoli Storage Manager package group.
5. Enter N for Next.
6. Choose to uninstall the IBM Tivoli Storage Manager Operations Center

package.
7. Enter N for Next.
8. Enter U for Uninstall.
9. Enter F for Finish.
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Uninstalling the Operations Center in silent mode
To uninstall the Operations Center in silent mode, you must run the uninstallation
program of IBM Installation Manager from the command line with the parameters
for silent mode.

Before you begin

The input directory, which is in the directory where the installation package is
extracted, contains the following sample response files for installing, updating, and
uninstalling the Operations Center:
v install_response_sample.xml

v update_response_sample.xml

v uninstall_response_sample.xml

You can use these sample files as they are, with the default values, or you can
customize them.

Procedure
1. In the directory where IBM Installation Manager is installed, go to the

following subdirectory:
eclipse/tools

For example:
/opt/IBM/InstallationManager/eclipse/tools

2. From the tools directory, issue the following command, where response_file
represents the response file path, including the file name:

./imcl -input response_file -silent

The following command is an example:

./imcl -input /tmp/input/uninstall_response.xml -silent
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Chapter 15. Rolling back to a previous version of the
Operations Center

By default, IBM Installation Manager saves earlier versions of a package to roll
back to if you experience a problem with later versions of updates, fixes, or
packages.

Before you begin

The rollback function is available only after the Operations Center is updated.

About this task

When IBM Installation Manager rolls back a package to a previous version, the
current version of the package files is uninstalled, and an earlier version is
reinstalled.

To roll back to a previous version, IBM Installation Manager must access files for
that version. By default, these files are saved during each successive installation.
Because the number of saved files increases with each installed version, you might
want to delete these files from your system on a regular schedule. However, if you
delete the files, you cannot roll back to a previous version.

To delete saved files or to update your preference for saving these files in future
installations, complete the following steps:
1. In IBM Installation Manager, click File > Preferences.
2. On the Preferences page, click Files for Rollback, and specify your preference.

Procedure

To roll back to a previous version of the Operations Center, use the Roll Back
function of IBM Installation Manager.
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Appendix A. Installation log files

If you experience errors during installation, these errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the Installation
Manager tool. To collect these log files, click Help > Export Data for Problem
Analysis from the Installation Manager tool.
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Appendix B. Tivoli support information

You can find support information for Tivoli and other IBM products from various
sources.

From the IBM Support Portal at http://www.ibm.com/support/entry/portal/, you
can select the products that you are interested in and search for a wide variety of
relevant information.

Communities and other learning resources
In addition to product documentation, many forms of assistance are available to
help you get started as you deploy and use the Tivoli Storage Manager family of
products. These resources can also help you to solve problems that you might
have.

You can use forums, wikis, and other social media tools to ask questions, talk to
experts, and learn from others.

User groups

Tivoli Global Storage Virtual User Group
Access this user group at http://www.tivoli-ug.org/storage.

This group makes it possible for individuals from many different industries
and types of organizations to share information and work directly with the
IBM product experts. Local chapters also exist where members meet in
person to share experiences and hear from guest speakers.

ADSM.ORG
Access this mailing list at http://adsm.org.

This independently managed Storage Management discussion forum
started when Tivoli Storage Manager was known as ADSTAR Distributed
Storage Manager (ADSM). The members of this forum have many years of
experience with Tivoli Storage Manager in almost every type of IT
environment.

To subscribe to the forum, send an email to listserv@vm.marist.edu. The
body of the message must contain the following text: SUBSCRIBE ADSM-L
your_first_name your_family_name.

Tivoli Storage Manager community on Service Management
Connect

Access Service Management Connect at http://www.ibm.com/developerworks/
servicemanagement. In the Storage Management community of Service
Management Connect, you can connect with IBM in the following ways:
v Become involved with transparent development, an ongoing, open engagement

between users and IBM developers of Tivoli products. You can access early
designs, sprint demonstrations, product roadmaps, and prerelease code.

v Connect one-on-one with the experts to collaborate and network about Tivoli
and the Tivoli Storage Manager community.

v Read blogs to benefit from the expertise and experience of others.
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v Use wikis and forums to collaborate with the broader user community.

Tivoli Storage Manager wiki on developerWorks®

Access this wiki at https://www.ibm.com/developerworks/servicemanagement/
sm/index.html.

Find the latest best practices, white papers, and links to videos and other
resources. When you log on, you can comment on content, or contribute your own
content.

Tivoli Support Technical Exchange

Find information about upcoming Tivoli Support Technical Exchange webcasts at
http://www.ibm.com/software/sysmgmt/products/support/supp_tech_exch.html.
Replays of previous webcasts are also available.

Learn from technical experts who share their knowledge and then answer your
questions. The sessions are designed to address specific technical issues and
provide in-depth but narrowly focused training.

Other social media sites

LinkedIn
You can join groups on LinkedIn, a social media site for professionals. For
example:
v Tivoli Storage Manager Professionals: http://www.linkedin.com/

groups/Tivoli-Storage-Manager-Professionals-54572
v TSM: http://www.linkedin.com/groups?gid=64540

Twitter
Follow @IBMStorage on Twitter to see the latest news about storage and
storage software from IBM.

Tivoli education resources

Use these education resources to help you increase your Tivoli Storage Manager
skills:

Tivoli Education and Certification website
View available education at http://www.ibm.com/software/tivoli/
education.

Use the Search for Training link to find local and online offerings of
instructor-led courses for Tivoli Storage Manager.

Education Assistant
Access resources at http://publib.boulder.ibm.com/infocenter/ieduasst/
tivv1r0/index.jsp.

Scroll to view the list of available training videos. Recorded product
demonstrations are also available on a YouTube channel.
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Searching knowledge bases
If a problem occurs while you are using one of the Tivoli Storage Manager family
of products, you can search several knowledge bases.

Begin by searching the Tivoli Storage Manager Information Center at
http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1. Within the information center,
you can enter words, phrases, or message numbers in the Search field to find
relevant topics.

Searching the Internet
If you cannot find an answer to your question in the Tivoli Storage Manager
information center, search the Internet for the information that might help you
resolve the problem.

To search multiple Internet resources, go to the IBM support website at
http://www.ibm.com/support/entry/portal/. You can search for information
without signing in.

Sign in using your IBM ID and password if you want to customize the site based
on your product usage and information needs. If you do not already have an IBM
ID and password, click Sign in at the top of the page and follow the instructions
to register.

From the support website, you can search various resources:
v IBM technotes.
v IBM downloads.
v IBM Redbooks® publications.
v IBM Authorized Program Analysis Reports (APARs). Select the product and click

Downloads to search the APAR list.

Using IBM Support Assistant
IBM Support Assistant is a complimentary software product that can help you with
problem determination. It is available for some Tivoli Storage Manager and Tivoli
Storage FlashCopy® Manager products.

IBM Support Assistant helps you gather support information when you must open
a problem management record (PMR), which you can then use to track the
problem. The product-specific plug-in modules provide you with the following
resources:
v Support links
v Education links
v Ability to submit problem management reports

You can find more information and download the IBM Support Assistant web page
at http://www.ibm.com/software/support/isa.

You can also install the stand-alone IBM Support Assistant application on any
workstation. You can then enhance the application by installing product-specific
plug-in modules for the IBM products that you use. Find add-ons for specific
products at http://www.ibm.com/support/docview.wss?uid=swg27012689.
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Finding product fixes
A product fix to resolve a software problem might be available from the IBM
software support website.

Procedure

Determine what fixes are available by checking the IBM software support website
at http://www.ibm.com/support/entry/portal/.

If you previously customized the site based on your product usage:

1. Click the link for the product, or a component for which you want to
find a fix.

2. Click Downloads, and then click Search for recommended fixes.

If you have not previously customized the site:
Click Downloads and search for the product.

Receiving notification of product fixes
You can receive notifications about fixes, flashes, upgrades, and other news about
IBM products.

Procedure
1. From the support page at http://www.ibm.com/support/entry/portal/, click

Sign in and sign in using your IBM ID and password. If you do not have an
ID and password, click register now and complete the registration process.

2. Click Manage all my subscriptions in the Notifications pane.
3. Click the Subscribe tab, and then click Tivoli.
4. Select the products for which you want to receive notifications and click

Continue.
5. Specify your notification preferences and click Submit.

Contacting IBM Software Support
You can contact IBM Software Support if you have an active IBM subscription and
support contract, and if you are authorized to submit problems to IBM.

Procedure
1. Ensure that you have completed the following prerequisites:

a. Set up a subscription and support contract.
b. Determine the business impact of the problem.
c. Describe the problem and gather background information.

2. Follow the instructions in “Submitting the problem to IBM Software Support”
on page 138.
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Setting up and managing support contracts
You can set up and manage your Tivoli support contracts by enrolling in IBM
Passport Advantage. The type of support contract that you need depends on the
type of product you have.

Procedure

Enroll in IBM Passport Advantage in one of the following ways:
v Online: Go to the Passport Advantage website at http://www.ibm.com/

software/lotus/passportadvantage/, click How to enroll, and follow the
instructions.

v By telephone: For critical, system-down, or high-severity issues, you can call
1-800-IBMSERV (1-800-426-7378) in the United States. For the telephone number
to call in your country, go to the IBM Software Support Handbook web page at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html
and click Contacts.

Determining the business impact
When you report a problem to IBM, you are asked to supply a severity level.
Therefore, you must understand and assess the business impact of the problem
you are reporting.

Severity level Description

Severity 1 Critical business impact: You are unable to use the program,
resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2 Significant business impact: The program is usable but is
severely limited.

Severity 3 Some business impact: The program is usable with less
significant features (not critical to operations) unavailable.

Severity 4 Minimal business impact: The problem causes little impact on
operations, or a reasonable circumvention to the problem has
been implemented.

Describing the problem and gathering background information
When explaining a problem to IBM, it is helpful to be as specific as possible.
Include all relevant background information so that IBM Software Support
specialists can help you solve the problem efficiently.

To save time, know the answers to these questions:
v What software versions were you running when the problem occurred?
v Do you have logs, traces, and messages that are related to the problem

symptoms? IBM Software Support is likely to ask for this information.
v Can the problem be re-created? If so, what steps led to the failure?
v Have any changes been made to the system? For example, hardware, operating

system, networking software, and so on.
v Are you using a workaround for this problem? If so, be prepared to explain it

when you report the problem.
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Submitting the problem to IBM Software Support
You can submit the problem to IBM Software Support online or by telephone.

Online
Go to the IBM Software Support website at http://www.ibm.com/
support/entry/portal/Open_service_request/Software/
Software_support_(general). Sign in to access IBM Service Requests and
enter your information into the problem submission tool.

By telephone
For critical, system-down, or severity 1 issues, you can call 1-800-IBMSERV
(1-800-426-7378) in the United States. For the telephone number to call in
your country, go to the IBM Software Support Handbook web page at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/
home.html and click Contacts.
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Appendix C. Accessibility features for the Tivoli Storage
Manager product family

Accessibility features help users who have a disability, such as restricted mobility
or limited vision to use information technology products successfully.

Accessibility features

The IBM Tivoli Storage Manager family of products includes the following
accessibility features:
v Keyboard-only operation using standard operating-system conventions
v Interfaces that support assistive technology such as screen readers

The command-line interfaces of all products in the product family are accessible.

Tivoli Storage Manager Operations Center provides the following additional
accessibility features when you use it with a Mozilla Firefox browser on a
Microsoft Windows system:
v Screen magnifiers and content zooming
v High contrast mode

The Operations Center and the Tivoli Storage Manager Server can be installed in
console mode, which is accessible.

The Tivoli Storage Manager Information Center is enabled for accessibility. For
information center accessibility information, see “Accessibility features in the
information center” ( http://pic.dhe.ibm.com/infocenter/tsminfo/v7r1/topic/
com.ibm.help.ic.doc/iehs36_accessibility.html).

Vendor software

The Tivoli Storage Manager product family includes certain vendor software that is
not covered under the IBM license agreement. IBM makes no representation about
the accessibility features of these products. Contact the vendor for the accessibility
information about its products.

IBM and accessibility

See the IBM Human Ability and Accessibility Center (http://www.ibm.com/able)
for information about the commitment that IBM has to accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who want to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
_enter the year or years_.

If you are viewing this information in softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at http://www.ibm.com/legal/copytrade.shtml.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or
its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Privacy policy considerations
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
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and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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Glossary

A glossary is available with terms and definitions for the IBM Tivoli Storage Manager family of products.

You can view the glossary in the Tivoli Storage Manager information center at http://pic.dhe.ibm.com/
infocenter/tsminfo/v7r1.

To view glossaries for other IBM products, see http://www.ibm.com/software/globalization/
terminology/.
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